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SECTION 1 OVERVIEW
The MicroType 3.0 software is a keyboarding program that consists of a tutorial,
reinforcement activities, educational games, and a word processor. All of these components are combined in one comprehensive package that will help your students master the
basic keyboarding skills.
This manual provides the necessary information to help you install the software and
prepare it for use in your classroom. Teaching suggestions explore the process of
developing and assessing keyboarding skills. Other sections discuss each major feature of
the MicroType 3.0 software. There are also troubleshooting tips that are provided in the
event you run into any problems while using the program.
The MicroType 3.0 software is a result of the feedback we have received from
educators over many years. As always, we look forward to your comments regarding this
new program. Your suggestions will help us enhance the product in subsequent revisions.
MicroType 3.0 Features
As you and your students work with the MicroType 3.0 software, you will discover that
it contains numerous features that will enhance the learning process. The following list
briefly describes the major product features.
 Alphabetic Keyboarding  Includes 20 lessons that teach the alphabetic keys,
shift keys, SPACE BAR, ENTER/RETURN, CAPS LOCK, TAB, and the basic
punctuation keys. Every lesson includes several different activities to learn new
keys, combine keys, improve keystroking, and build skill. The Key-A-Shot game
challenges students to improve their keyboarding skills by offering an exciting, yet
pedagogically sound approach to learning. A Lesson Report reflects the students
performance for each activity.
 Numeric Keyboarding  These 16 lessons teach the top-row figure keys and
the more commonly used symbols. The Numeric Keyboarding section provides the
same basic activities as the Alphabetic Keyboarding module. However, the
activities that focus on building skill include both sentences and paragraphs for
students to key. Students can access the Diagnostic Writings feature from the
lesson menu to analyze their progress. The Connect It game allows students to earn
game time by keying drill lines.
 Keyboarding Skill Builder  In these 20 lessons, students can improve their
keyboarding speed and control after they learn the alphabetic and numeric key
reaches. You can choose whether students work on improving speed or accuracy.
Lesson activities include Keyboard Mastery, Improve Technique, Sentences,
Paragraphs, and Measurement Writing. More difficult drills challenge students as
they move from lesson to lesson. The Mystery Puzzle game reinforces keyboarding
skills by encouraging students to work on improving speed and accuracy as they
earn extra game chances. Students can access the Diagnostic Writings feature from
the lesson menu to analyze their progress.
 Numeric Keypad  Students learn the numeric keypad operation by completing
the four lessons in this section. Additional options allow your students to practice
using the numeric keypad and analyze their keypad skill. The Worldwide Shipping,
Inc. game provides a fun way to practice the reaches learned in each lesson.
 Skill Analysis  The Skill Analysis feature allows MicroType 3.0 to diagnose
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students keying ability prior to beginning the lessons. After students complete the
Skill Analysis timed writing, the program will suggest the appropriate lesson mode.
 Open Screen The Open Screen is a full-featured word processor that includes
numerous formatting options, a spell checker, and a built-in timer. Students can
practice their keyboarding skills, key letters and reports, and take a speed timed
writing. Students can choose a count-down timer for speed timed writings. They
can select a 15 or 30 second, 1', 3', 5' or variable-length timed writing. For
production work, students can set a count-up timer. Even if they save their work
and continue the next day, the count-up timer properly records their results.
 Diagnostic Writings  Using the Diagnostic Writings feature, you can evaluate
your students skills and identify possible areas for reteaching. This option
evaluates every keystroke and classifies the keying errors by category (e.g., misspelled word, capitalization, transposed characters, etc.). Students are also given
the opportunity to practice their errors.
 Quick Review  The Quick Review section presents drill lines for students to
practice the following: Alphabetic Keys, Numeric Keys, Easy Lines, ENTER/
RETURN, SPACE BAR, SHIFT KEYS, CAPS LOCK, and TAB.
 Games  Each of the keyboarding modules (Alphabetic Keyboarding, Numeric
Keyboarding, Keyboarding Skill Builder, and Numeric Keypad) incorporate a game
into various lessons. These games are designed to be fun, but still focus on
improving keyboarding. The games offer exciting graphics and action needed to
maintain interest throughout the course. Top ten lists that show student performance also challenge students to constantly improve their keyboarding speed and
accuracy.
 Movies and 3-D Viewer  Movies and 3-D viewers are available throughout the
lessons. Students can watch demonstrations of proper posture and keying
technique, control models illustrating correct finger placement on the keyboard,
and adjust finger and wrist position using the slider bar image.
 Emphasis on Correct Technique Acquiring correct keyboarding technique is
the primary objective of beginning keyboarding instruction. Correct keyboarding
technique includes proper body, hand, and finger position; proper keystroking
technique; proper spacing and shifting technique; and immediate return at the ends
of lines. Correct keyboarding technique is reinforced by the movies, 3-D viewers,
photos, and technique hints presented throughout the lessons.
 Flexible Processing of Student Input  The MicroType 3.0 software constantly monitors a students input and it provides different processing methods
during each lesson. The program accepts only correct responses while a student
learns a new key. As a student works to improve his/her keystroking skill, the
software checks for both speed and accuracy. Skill building exercises focus on
increasing speed, but the program analyzes a students input to verify that the input
meets minimum accuracy standards.
 Graphic Character  A graphic character called Typo introduces new keys and
guides students throughout the tutorial. Typo maintains student interest as they use
the software.
 Student Performance Records  The MicroType 3.0 software includes
numerous reports that keep you informed about your students progress. Some of
2
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the reports include: Lesson Reports, Summary Report, Diagnostic Report, and
Class Summary Report.
 BACKSPACE/DELETE  By default, the BACKSPACE/DELETE key is
available. However, you can control whether the BACKSPACE/DELETE key is
available as your students complete the various keyboarding lessons. When
appropriate, the program indicates the status of the BACKSPACE/DELETE key.
 Extensive On-Line Help  On-line help is available throughout the program.
Simply click on the Help button to instantly access detailed information about the
software.
 Keyboarding Preferences  The program includes preset software Preferences that
you can use to restrict the use of the BACKSPACE/DELETE key, provide access to
the games or movies, determine if students should focus on speed or accuracy, set the
minimum accuracy requirement for drills, select the audio and text language, and more.
You can control these and other aspects of the MicroType 3.0 software. And, you can
prevent your students from changing the options you set.
 Send File Feature  The Send File feature allows a student in a distance
learning environment to send his/her data file to you for review (Windows only).
Technical Support Hotline
The Technical Support Hotline (1-800-423-0563) is available to help you with any
technical problems you may be having with this software. You can also reach the hotline
by e-mail at support@kdc.com or by fax at 1-859-647-5045. If you identify a problem,
please check your hardware to make sure it is working properly. If the hardware is
functioning correctly, call the hotline number. Please have the following information and
materials with you when calling the hotline:
 program CD-ROM
 textbook (if any)
 Users Guide
 list of any error messages
 printouts
 description of the problem
 computer type and model
 operating system version
 computers memory configuration
Please do not permit your students access to the hotline number. If you want to order
software, call (800) 354-9706. If you need product information, call (800) 824-5179.
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SECTION 2 DEVELOPING AND ASSESSING
KEYBOARDING SKILL
Keyboarding skill is best acquired through repetition of appropriate responses.
Students learn the location of keys as they relate to other keys and combinations of keys,
and they learn the reach to any key from its related home key. Initial responses only
approximate the desired keystroking response. Immediate feedback is imperative to the
process of keyboard learning, as the learner uses the feedback to respond with keystroking
more and more like that of a skilled operator. Therefore, a student should be able to
determine whether he or she made a correct keystroke as the keystroke is made. Software
makes the immediate affirmation of correct stroking possible. Also, you must observe
each student frequently and offer immediate feedback about correct position at the
keyboard and proper keystroking technique.
When teaching a new key, present the key orally and demonstrate the reach. Have
students watch their fingers during the reach-learning process. Thereafter, students may
look at their hands occasionally to reaffirm a reach or key location. Encourage students
to watch the screen or the textbook to verify a key location. As students become more
familiar with the keyboard, they will automatically rely on finger peeking less and will
watch the screen or textbook more. Encouraging reliance on the screen will develop
intuitive key reaches more quickly.
The following points are important for maximizing the learning level of the students:
 Keyboard learning is cumulative; therefore, it is important that students know
previously taught keys before new keys are introduced.
 To develop keyboarding skill, students must first learn key locations and key
reaches. Then they must practice those key reaches, relative to the home-keys, to
begin to develop automatic key reach responses. Keyboard mastery results from
the use of correct keying techniques during practice over an extended period.
 Beginning students need constant supervision during the early stages of learning.
Observe students operating techniques to ensure that correct techniques are used.
Practice makes perfectbut NOT just any practice. Keying skill (speed and
accuracy) is acquired through frequent, correct repetitive practice.
 Immediate feedback is imperative to learning efficiency. Inform students immediately of what they are doing right and what they are doing wrong. During initial
learning and reinforcement practice, constant feedbackpositive reinforcement for
things done correctly and corrective suggestions for things done incorrectlyis
crucial to a students development of a usable keying skill. Thus the focus must be
on the process taking place in the classroom, rather than the products (printouts)
that result.
Processing Methods
Various processing methods are used throughout the tutorial sections of the software
to reinforce specific keyboarding skills. The MicroType 3.0 program employs the following
methods to process student keying.
Line-Check Mode
MicroType 3.0 uses the line-check method to analyze drill material keyed for speed.
The program analyzes a students input after he/she strikes ENTER/RETURN. If a
4
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student meets the accuracy requirement, the gwam rate appears; otherwise, the program
displays the Too many errors. message.
NOTES:
1. Depending on the Preferences setting, the BACKSPACE/DELETE key may or may
not be available while students use the line-check practice technique.
2. You can set the accuracy requirement using the teacher utilities.
Lock-and-Flash Mode
The lock-and-flash technique is used when a student learns new keys. If a student
makes a keying error, the MicroType 3.0 program flashes the correct key and demonstrates
the proper key reach. A student must strike the correct key before continuing. The
BACKSPACE/DELETE key is never available for the lock-and-flash mode.
Word-Lock Mode
Word-lock mode is an instructional technique that reinforces specific reaches or
techniques. Using this method, the program displays the entire drill line and then checks
each letter as a student keys it. If a student makes an error, the program erases the whole
word or word group so that the student can key it again.
The program requires that a student key the first letter of each word correctly. The
program allows a student to attempt each word up to three times. After three tries, the
program displays the last incorrect attempt and moves on to the next word. The BACKSPACE/DELETE key is never available while your students key drill lines in this mode.
Word-Flash Mode
Word-flash is a variation of the word-lock mode in which the program displays one
word at a time (instead of the entire drill line) and then checks each letter as a student keys
it. If the student makes an error, the program erases the whole word so that the student
can key it again. The BACKSPACE/DELETE key is never available for this mode.
Word-Lock Mode (Numeric Keypad)
Word-lock mode is an instructional technique that reinforces specific reaches or
techniques. Using this method, the program displays a column of numbers to key. The
program checks each digit as it is keyed. If a student makes an error, the program erases
the entire number so that it can be keyed again.
The program requires that a student keys the first digit of each number correctly. A
student may attempt each number up to three times. After three tries, the program
displays the last incorrect attempt and allows the student to move on to the next number.
The BACKSPACE/DELETE key is never available while using this mode.
Column-Check Mode
MicroType 3.0 uses the column-check method to analyze numeric keypad drills keyed
for speed. The program analyzes input after a student strikes ENTER/RETURN for the
last figure in the column. If a student meets the accuracy requirement, the kspm rate
appears; otherwise, the program displays the Too many errors. message.
NOTES:
1. Depending on the Preferences setting, the BACKSPACE/DELETE key may or may
not be available for this practice technique.
Section 2 Developing and Assessing Keyboarding Skill
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2. You can set the accuracy requirement using the teacher utilities.
Speed and Accuracy
Neither speed nor accuracy can be taught or learned directly; both are eventual
outgrowths of proper technique, and neither should be emphasized too early. The
sequence of emphasis in teaching/learning a skill isfirst, technique or good form; next,
speed; and finally, control (accuracy). During initial keyboard learning, timings that
emphasize how fast? are not recommended because they divert student attention from
the main goal of developing good keystroking technique patterns.
Concern about accuracy of the text students key is equally inappropriate during
keyboard learningand for the same reason. Furthermore, early accuracy emphasis,
penalties, and error limitations represent a negative approach to skill building because they
result in student frustration and discouragement.1 Research further verifies that correct
technique is a critical ingredient of early keyboard learning.
Performance Expectations
Students should be expected eventually to key faster than they can write. This goal
supports the theory underlying all innovations. The new must be better than the current
or it will not be used.
Generally speaking, speed expectations in the range of 15 to 25 words a minute (gross
words a minutes, or gwam) for beginners in the first six to eight weeks is realistic. The
following table indicates the skill levels (gross words a minute, or gwam, and errors a
minute, or eam) most students should be able to attain after a given number of hours of
well-monitored instruction:
Hours of Instruction
30 hours
60 hours
90 hours
120 hours

Speed Expectation
18 - 27 gwam
23 - 33 gwam
26 - 37 gwam
40 - 52 gwam

Accuracy Expectation
5 eam
4-3 eam
3-2 eam
2-1 eam

The following table gives the approximate speed (keystrokes per minute, or kspm) and
accuracy levels correlated with the hours of instruction on the numeric keypad. Most
students should be able to attain these levels.
Hours of Instruction
Speed Expectation
Accuracy Expectation
2.5 hours
18 - 27 kspm
1.00 eam
5 hours
23 - 33 kspm
0.47 eam
10 hours
26 - 37 kspm
0.38 eam
12 hours
40 - 52 kspm
0.36 eam
15 hours
40 - 52 kspm
0.35 eam
Using the Correlated Textbook
The Alphabetic and Numeric modules in the MicroType software are correlated with
Century 21 Computer Applications & Keyboarding, 7th Edition and Century 21 Computer
Keyboarding, 7th Editon.
You can use the MicroType 3.0 software for remedial practice, paced writings,
individualized-goal timings, and short-interval measurement writings. Whether used as
Jerry W. Robinson, and others, Typewriting: Learning and Instruction. (Cincinnati: SouthWestern Publishing Co., 1979).
1
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the primary means for delivering instruction or used in support of teacher-directed
instruction, computers have their limitations. Computers cannot see; so they cannot
observe students at work and make appropriate suggestions for improving keyboarding
technique. They cannot hear; therefore, they cannot answer students calls for help.
Computers cannot feel; so they cannot deal with learning problems that derive from
students emotions and attitudes. Thus a knowledgeable, caring teacher is needed to
provide the seeing, hearing, and feeling links in the instruction/learning process.
Effective Evaluation and Use of Performance Data
The MicroType 3.0 software provides a wealth of valuable data about student
performance, including a record of lessons parts completed, speeds on skill-building
activities, counts and analyses of errors, and even students keying lines. An important
question becomes how to use this data most effectively.
In keyboarding, the proper use of evaluation has a fourfold purpose:
1. To lead to more rapid acquisition of keying knowledge and skill
2. To meet the psychological needs of the student by answering the question How well
am I currently performing?
3. To improve the quality of instruction by answering questions about the appropriateness and effectiveness of your teaching/learning strategies (methods and materials)
4. To serve as a measure of the level of competence attained by the student, a measure
that should include more than mere speed and accuracy assessment.2
Evaluation both facilitates and measures student learning. Two distinct types of
evaluation are needed to serve these purposes. One type (formative) develops or forms
skill; the other (summative) measures or sums up the results of learning. Or, as Brandt
reportedly stated, formative evaluation performs a decision-making function; whereas,
summative evaluation performs an accountability functionDid the decisions work?3
Formative evaluation is used during instruction and practice to diagnose problems, set
goals and determine remedial needsnot to assign grades. Bloom wrote, according to
Robinson and his coauthors, that formative evaluation (i.e., observations) helps teachers
determine the degree of mastery of a given learning task and to pinpoint the part of the
task not mastered.4
Summative evaluation is used to determine an appropriate grade assignment. This kind
of evaluation should occur at the end of a unit or near the end of a grading period as a
means of assessing students skill levels at the time a grade must be assigned. In Blooms
words, reported by Robinson et. al., summative evaluation is directed toward a much
more general assessment of the degree to which the larger outcomes have been attained
over the entire course or some substantial part of it.5
In the early phases of keyboard learning, the focus should be on formative evaluation.
Use the data provided by the program and data gathered by observation to determine
which aspects of keyboarding skill the student has acquired and which still need work.
Use the data to teach the student, not to grade the student.
2
3
4
5

Robinson
Robinson
Robinson
Robinson

and
and
and
and

others,
others,
others,
others,

p.
p.
p.
p.

157.
156.
17.
17.
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Blooms work on formative and summative evaluation was further cited by Robinson
and his colleagues: In learning any psychomotor skill, an essential component of the
learning process is an active teacher who observes and evaluates the process of learning
(the performance) and provides feedback in the form of correctives (comments and
demonstrations) to help the student improve. Herein lies a major difference between
teaching and grading. In the early stages of learning any new task, evaluation should be
of the process not of the product. Only after the process has been mastered should the
evaluation of the product (what the student types) occur.6
The MicroType 3.0 lesson exercises are ideal for building skill. They are designed to
motivate the student through individualized goal setting. The results of these activities
should be used for motivational, diagnostic, and goal-setting purposesnot for grading.
One-minute and three-minute timed writings serve as skill builders while longer
writings measure (summative evaluation) skill. The student should use the data from
writings to develop a personal profile that can be helpful in determining changes needed
in teaching and to set direction for future practice. The profile can also be used to
compare skill growth patterns with expected competencies.
Summative evaluationexcept for the rating techniquesshould be postponed until
after the student has acquired good basic keyboarding technique and a reasonable degree
of fluency. Only then should emphasis be placed on the productwhat the student keys.
Summative evaluation provides valuable information not only in grading a students
performance, but also in grading the quality of the instruction given.

6

Robinson and others, p. 17.
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SECTION 3 INSTALLATION PROCEDURES
System Requirements
The following minimum system requirements are necessary to run the MicroType 3.0
software.
Windows
 PC (or 100%-compatible) with 233 MHz Pentium II or higher processor
 32 MB RAM (64 MB required for Windows 2000)
 Hard disk with 40 MB free (plus 100 MB to run movies from hard drive instead of
the CD-ROM)
 Windows 95, 98, Me, XP, 2000
 CD-ROM drive
 Soundblaster compatible sound card and speakers
 800 x 600 monitor capable of displaying 256 colors
 10 Megabit Ethernet (100 Megabit recommended) for network operation
Macintosh
 Macintosh (or 100%-compatible) computer with Power PC 200 MHz or higher
processor; G3 processor recommended
 32 MB RAM
 Hard disk with 120 MB free (plus 100 MB to run movies from hard drive instead
of the CD-ROM)
 System 8.0 or higher
 CD-ROM drive
 640 x 480 color monitor set to display 256 colors or more
 10 Megabit Ethernet (100 Megabit recommended) for network operation
Installation Procedures (Windows)
Follow the steps provided below to install the MicroType 3.0 software at each
computer or workstation.
Step 1

Insert the MicroType 3.0 disc into the CD-ROM drive.

Step 2

Click the Start button, and choose Run.

Step 3

Key x:\setup, where x is the letter of your CD-ROM drive, and strike
ENTER/RETURN.

Step 4

Follow the instructions that appear on the screen to complete the installation
process.
The installer will give you the option to install only the program or install both
the program and the movies. For better performance, it is recommended that
you install the program and the movies.

Step 5

After installing the software, store the disc in a secure location.

Section 3
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Installation ProceduresNetwork (Windows)
The MicroType 3.0 software can be copied onto a network server following the steps
provided here, but it is strongly recommended that you install the program at each
workstation. Regardless of where you install the program, you can use the networks
resources to print reports and store students performance data.
IMPORTANT: Before you begin the installation process, make sure that Windows
95, (or a more recent Windows operating system) is installed on each workstation and
that you have the necessary access privileges to install a program on the network server.
You must have read/write privileges to the program folder on the network. Otherwise,
the installation process will not be successful.
Step 1

Insert the MicroType 3.0 CD-ROM into the CD-ROM drive.

Step 2

Click the Start button, and choose Run.

Step 3

Key x:\setup, where x is the letter of your CD-ROM drive, and strike
ENTER/RETURN.

Step 4

Follow the instructions that appear on the screen to complete the installation
process. You will need to specify the network folder (e.g., x:\Program
Files\microtype3).
The installer will give you the option to install only the program or install both
the program and the movies. If you want access to the movies, it is recommended that you install the movies on your server. If you do not install the
movies, the program will attempt to play a movie, when it is needed, from the
local CD-ROM device.

Step 5

After installing the software, store the original disc in a secure location.

Step 6

Identify where you want students to store their data. You will need to provide
the appropriate access to the various folders on the network server.
Give each student read access privileges to all of the program folders.
Students will need read and write access to any folder where they will save
data or documents. For example, you must specify write access to the location
where students will save their word processor documents. Also, there is a top
ten file that stores the top scores for certain games. You must provide write
access to the folder (TopTen) that contains this file too.
NOTE: MicroType 3.0 creates a Student folder as part of the installation
process. By default, a student sub-folder is added to the Student folder each
time a new student account is created (e.g. Students\Tina Lopez). To organize
your student data files easily, it is recommended that students save their word
processor documents in their student sub-folder. If you prefer that student subfolders not be created, you may turn off this option using Teacher Utilities.

Steps 7

At each computer create a program shortcut icon. Performing this step provides
the computer with the necessary information so that your students can easily
access the software.
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Step 8



Choose the Select Menu Program tab (or the Advanced tab on Windows 2000)
and click the Add button.



Use the Browse button to identify the location of the program on the
network server.



Proceed to the next screen and create a new folder called South-Western
Keyboarding in the Programs folder unless you have already installed other
versions of the software.



On the next screen, enter a shortcut that includes the program name (for
example, MicroType 3.0).



Indicate that you are finished.

Review the instructions in Section 4Preparing to Use the Keyboarding Software to
set the data locations for a network setup.

Installation Procedures (Macintosh)
Follow the steps provided here to install the MicroType 3.0 software at each computer
or workstation.
Step 1

Insert the MicroType 3.0 disc into the CD-ROM drive.

Step 2

Open the CD-ROM window, if necessary.

Step 3

Double-click the installation icon to start the program.

Step 4

Follow the instructions that appear on the screen to complete the installation
process.
The installer will give you the option to install only the program or install both
the program and the movies. For better performance, it is recommended to
install the both the program and the movies.

Step 5

After installing the software, store the original disc in a secure location.

Step 6

Verify that QuickTime 4.0 (or a more recent version) is already installed on the
computer. QuickTime is required to view the movies. If it is not installed,
check the Apple website to download the latest QuickTime installer.

Installation ProceduresNetwork (Macintosh)
The Typing Time software can be copied onto a network server following the steps
provided here, but it is strongly recommended that you install the program at each
workstation. Regardless of where you install the program, you can use the networks
resources to print reports and store students performance data.
IMPORTANT: Before you begin the installation process, make sure that you have the
necessary access privileges to install a program on the network server. Otherwise, the
installation process will not be successful.
Step 1

Insert the MicroType 3.0 disc into the CD-ROM drive.

Step 2

Open the CD-ROM window, if necessary.

Step 3

Double-click the installation icon to start the program.

Section 3
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Step 4

Follow the instructions that appear on the screen to complete the installation
process. You will need to specify the network folder (e.g.,
Network:MicroTYpe 3.0).
The installer will give you the option to install only the program or install both
the program and the movies. If you want access to the movies, it is recommend
that you install the movies on your server. If you do not install the movies, the
program will attempt to play a movie when it is needed from the local CDROM device.

Step 5
Step 6

After installing the software, store the original disc in a secure location.
At each workstation, enable file sharing and program linking to access the
program on the network server.

Step 7

Verify that QuickTime 4.0 (or a more recent version) is already installed on the
computer. QuickTime is required to view the movies. If it is not installed,
check the Apple website to download the latest QuickTime installer.

Step 8

Identify where you want students to store their data. You will need to provide
the appropriate access to the various folders on the network server.
Give each student read access privileges to all of the program folders.
Students will need read and write access to any folder where they will save
data or documents. For example, you must specify write access to the
location where students will save their word processor documents. Also, there
is a top ten file that stores the top scores for certain games. You must provide
write access to the folder (TopTen) that contains this file too.

Step 9

Review the instructions in Section 4Preparing to Use the Keyboarding Software to
set the data locations for a network setup.

Other Network Considerations
Even if you do not install the MicroType 3.0 software onto a network server, you can
still use the networks resources to print reports and store students performance data.
Given the nature of multimedia applications, it is best to install this type of program on a
hard disk at each workstation for maximum performance.
If your computers are connected to a network, printing is handled automatically by
the keyboarding software. The program directs all reports to the specified printer and it
prints the students name on all performance reports.
The keyboarding software is also designed to allow students to save their work onto a
network server. By storing the performance data in one central location, you can easily
access your students data to generate a comprehensive report. (See the step-by-step
instructions in Recording Student Performance Data beginning on page 13.)
Another benefit of using a network, is that you can use it to store the default
preferences, diagnostic writings, and keypad timed writings. This option is especially
useful if you add your own diagnostic writings and keypad timed writings. Simply store
this information on the network and all of your students can access these files. On standalone computers, you must copy any new diagnostic writings to each computer.
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SECTION 4 PREPARING TO USE THE
KEYBOARDING SOFTWARE
Review the information in this section before your students begin using the MicroType
3.0 software. Instructions are provided to set the location for your students performance
data, enter the default Preferences, and add new student records. If you dont want to
maintain student performance data, this section also explains the Guest option.
Recording Student Performance Data
First, determine where you want your students to save their performance datafloppy
disk, local hard disk, or network. The setup you choose depends on your hardware
configuration and your particular needs. If you have access to a network for data storage,
however, this option probably provides the most flexibility and easiest use once you
establish the student records.
If you dont have a network, you must choose between using the local hard drive or a
floppy disk for data storage. Using the local hard disk, students dont have to handle
disks and storage capacity is not a concern. However, students must be assigned to a
particular computer and use it throughout the entire course because their data files are not
easily moved to another computer. With floppy disks, students can move from computer
to computer since all of their data is stored on floppy disks.
After you decide which option to use, refer to the appropriate instructions to set the
location for the student files. It is recommended that you set the data location before
your students begin using the keyboarding software.
IMPORTANT: If you install MicroType 3.0 on each computer and your students will
save their work on a local hard drive or a floppy disk, you most likely do not need to
change the data locations. The option to set the data locations is primarily used when
storing certain keyboarding files or student data on a network.
NOTE: If you dont want to keep track of any performance data, your students can
use the Guest option as described on page 16.
Floppy Disk
Changing the data location is optional when students will save their work on a floppy
disk. Instead of changing the location as described here, instruct your students to use the
Folder button each time they log in to the program.
Follow the steps given if you want to set the default student data location to a floppy
disk for Windows only. For the Macintosh, students must use the Folder button each
time they log in.
1. Start the MicroType 3.0 software.
2. At the Log In screen, access the teacher utilities by holding down the ALT key and
clicking the OK button. Enter the teacher password. The password is mtype3 unless
you already changed it.
3. Choose the Set Data Locations option.
4. Select the Override default folder radio button for Student Data and set the data
location for the student data to a floppy disk drive (e.g., A:\ or B:\).
When a student creates a new record, the default data location will be set to store his/
Section 4
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her work on a floppy disk. Make sure that your students have a disk ready each time
they start the keyboarding program.
5. Exit the teacher utilities and quit the program.
6. Repeat Steps 15 at each computer on which MicroType 3.0 is installed.
Hard Disk
When you installed the software, the installation program created a students
directory (folder) in the program directory. If you want all of your students to save their
performance data and other files in the same folder on the local hard disk, no other action
is necessary. The program is designed to automatically save the students work in the
students folder. However, you should assign each student to a particular computer.
Students should always use the same computer; otherwise, they wont be able to access
their files.
NOTE: By default, a student subfolder is added to the student folder each time a new
student account is created [e.g. c:\Program Files\MicroType 3\Students\Pat
Smith (Windows) or MicroType 3.0:Students:Pat Smith (Macinstosh)]. If you prefer
that student subfolders not be created, you may turn off this option using Teacher
Utilities.
Network
Whether you installed the MicroType 3.0 program on a network or on each computer,
you can take advantage of your network resources by storing your students performance
data and other keyboarding information in a central location on the network. For
example, you would be able to easily generate a Class Summary Report and instantly
update the Preferences for all students.
NOTE: You may change the data locations from a local hard drive to a network after
your students have used the software, but you must manually copy their performance data
to the network after following the instructions given here.
Depending on how you installed the keyboarding software, follow the steps provided
to prepare the software for a network environment.
MicroType 3.0 running from individual computers, but saving student
data to a network:
1. If necessary, create a primary student data location with a separate directory (folder)
on the network server for each student [e.g., x:\MicroType3\students\smith
(Windows) or Network:MicroType 3.0:Students:Smith (Macintosh)]. You may
create only one directory (folder) on the network to store all of your students records
instead of creating separate directories (folders).
IMPORTANT: Students must have read/write privileges to the directories (folders)
that you create on the network server in Step 1. Otherwise, they will not be able to
save their data on the network. Consult your network manual for more information.
2. Create a directory (folder) on the network server to hold the diagnostic writings and
default Preferences. Students will need read-access privileges to this location.
3. Start the MicroType 3.0 software.
14
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4. At the Log In screen, access the teacher utilities by holding down the ALT (Windows)
or OPTION (Macintosh) key and clicking the OK button. Enter the teacher password. The password is mtype3 unless you already changed it.
5. Choose the Set Data Locations option.
6. Select the Override default folder radio button for Student Data and set the location
for the student data to the primary student directory (folder) that you created in Step
1 [e.g., x:\MicroType3\students (Windows) or Network:MicroType 3.0:Students (Macintosh)].
Use the primary student path regardless of whether you created separate locations or
only one directory (folder) for all of your students. The MicroType 3.0 software will
automatically search the primary location and any subdirectories for the students
keyboarding files.
7. Select the Override default folder radio button for Default Preferences and
Diagnostic Writings and set the data location for the default Preferences and diagnostic
writings to the directory (folder) that you created in Step 2.
8. Exit the teacher utilities and quit the program.
9. Repeat Steps 38 at each computer.
10.Copy the Preferences and diagnostic writings from any computer to the new location
you set in Step 7. You need to copy the Preferences only if you already updated the
class settings. The files you need to copy are stored in the directory c:\Program
Files\MicroType3\options (Windows) or the path Microtype 3.0:Options
(Macintosh).
On a Windows system, the files that you need to copy have the following file name/
extensions: Preferences (mt3.prf) and diagnostic writings (.kdt). On a Macintosh
system, the files to copy are named appropriately, such as Writing 1, Group 1, and
MicroType3Prefs.
11.Access the teacher utilities option and set the default Preferences. (See page 16.) The
Preferences will be saved in the location you specified in Step 2.
MicroType 3.0 running from and saving student data to a network:
1. If necessary, create a primary student data location with a separate directory (folder)
on the network server for each student [e.g., x:\microtype3\students\smith
(Windows) or Network:MicroType 3.0:Students:Smith (Macintosh)]. However,
you may create only one folderon the network to store all of your students records
instead of creating separate folders.
IMPORTANT: Students must have read/write privileges to the directories (folders)
that you create on the network server in Step 1. Otherwise, they will not be able to
save their data on the network. Consult your network manual for more information.
2. After installing the MicroType 3.0 software on the network, make sure that students
have read-access privileges to the options folder located in the program folder on the
network.
3. If you want the program to update the top ten lists for the keyboarding games,
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students must have write-access privileges to the top ten folder. This folder is also
located in the program folder on the network.
4. Start the MicroType 3.0 software.
5. At the Log In screen, access the teacher utilities by holding down the ALT (Windows)
or OPTION (Macintosh) key and clicking the OK button. Enter the teacher password. The password is mtype3 unless you already changed it.
6. Choose the Set Data Locations option.
7. Select the Override default folder radio button for Student Data and set the location
for the student data to the primary student directory that you created in Step 1 [e.g.,
x:\microtype3\students (Windows) or Network:MicroType 3.0:Students
(Macintosh)]. Use the primary student path regardless of whether you created
separate locations or only one directory for all of your students. The MicroType 3.0
software will automatically search the primary location and any subdirectories for the
students keyboarding files.
IMPORTANT: You, the teacher, must have write-access privileges to the program
folder. MicroType 3.0 saves the data location, teacher password, and other information
in the program folder. If you dont have read/write access, the program will not be
able to update the data locations.
8. Set the default Preferences. (See below.)
9. Exit the teacher utilities and quit the program.
MicroType 3.0 running from a network and saving student data to a
floppy disk:
Changing the data location is not required when students save their work on a floppy
disk. When students log in, they should use the Folder button to select the data record
from a floppy disk.
Using the Guest Option
For those teachers who do not want to maintain student performance data, it is not
necessary to create a record for each student. Each time your students start the keyboarding software and log in, direct them to click the Guest button. Using the Guest option,
your students have full access to the MicroType 3.0 software. The only difference is that
the program does not save any student performance data as they work through the tutorial
lessons. However, students can save Open Screen (word processor) documents.
NOTE: You can disable the Guest button that appears on the Log In dialog box by
using the Set Data Locations option in the Teacher Utilities.
Setting Default Preferences
With MicroType 3.0, you can customize certain aspects of the software. For example,
you can permanently enable or disable the BACKSPACE/DELETE key, set the minimum
accuracy requirement, and turn sound on/off. You should set these default Preferences
before any students use the software or you create new student records.
The default Preferences are illustrated in Figure 4-1. If you want to change any of
these Preferences, it is recommended that you update the settings before your students
16
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Figure 4-1

Default Preferences (Teacher Utilities)

initially log in to the program. When a student creates a new record, the MicroType 3.0
program copies the default Preferences to the students personal record. Although you
can change a students Preferences any time during the course, its easier to set the
Preferences now. (See Update Class Preferences in Section 12Teacher Utilities on page 89
for instructions to change the default Preferences.)
Entering New Student Records
After you install the software, set the data locations, and update the default Preferences, the MicroType 3.0 software is ready for your students to begin using the program.
The first time your students use the keyboarding program, they must enter the following
information: name, Class ID, password, and data location.
Depending on your classroom environment, you may want to enter the new students
records yourself. This may avoid some problems such as students choosing the wrong data
location or forgetting their password. You can follow the same steps that your students
would use to register as a new user (page 21) or you can use the Update Student Information
teacher utility (page 85).
If you want to store your students performance results on a network, you may add
new records for the entire class at any computer. Make sure that you already set the data
location using the teacher utilities to identify where the data is to be stored on the
network.
If your students will be saving their work on the local hard drive, determine which
students will use the various computers. At each computer, create the new student
records for those students who will use that particular computer. Repeat these steps to
create new records for each student assigned to the computer. Move to the next
computer and repeat the same process.
If your students will be saving their work to a floppy disk, you will need a formatted
diskette for each student. At any computer, start the keyboarding program. Insert a
blank data diskette into a drive. Enter the student information. Windows: For the Data
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Path field, click the Folder button and then select drive A:\ or B:\ depending in which
drive the data disk is located. Macintosh: Click the Folder button to select the data
location for the new student record. The program will create the new student record on
the diskette. Remove the diskette from the drive and write the students name on the
disk label.
NOTE: You can disable the New User and Guest buttons that appear on the Log
In dialog box by using the Set Data Locations option in the Teacher Utilities. Disabling
these features will prevent students from inadvertently adding new records and using the
guest option.
Import/Export Student Records
MicroType 3.0 provides an option for you to import and export existing student
records. The import and export features in MicroType 3.0 allow you to import an existing
class list or export your MicroType 3.0 class list to a text (.txt) document. Class lists that
you import must be in text. (.txt) file format. If you already have a class list as a text
(.txt) file, using the import feature can be more efficient than creating new student
records manually.
(NOTE: Word processing documents can be easily converted to .txt files and then
imported into MicroType 3.0. Consult your word processing documentation for instructions on saving files in .txt file format.)
Follow the steps below to import/export class lists:
Importing a Class List
1. Choose the Update Student Information option from the Teacher Utilities menu.
2. Click the Folder icon to set the location where you would like the student records
imported.
3. Click the Import button.
4. Locate and select the text (.txt) file that contains your class list and click Open.
NOTE: If a student record already exists in MicroType 3.0, that students information
will not be imported.
IMPORTANT: The text file that contains the class list must be formatted using the
list of rules/guidelines below. Failure to follow the guidelines will result in an error when
importing your class list text file.
1. Each student name must be formatted as follows:
<last name>,<first name>,<class name>,<password>
Example:
Lopez,Tina,Class A,password
Smith,James,Class A,password
2. All four fields are required for each student name. If students are not assigned to a
class, leave the class field empty.
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Example:
Lopez,Tina,,password
3. Each field length must not exceed the maximum number of characters, listed below.
Exceeding the required field length will cause the students name to be skipped during
import.
Last name

20 characters

First name

20 characters

Class name

25 characters

Password

15 characters

4. In a case where a students name, class, or password includes a comma (,), the
comma must be preceded by a backslash (\).
Example:
Smith\, Jr.,James,Class A,password
Exporting a Class List
1. Choose the Update Student Information option from the Teacher Utilities menu.
2. Select a class from the Class ID drop-down menu. (Choose No Class Assigned if youd
like to export all of the students.)
3. Click the Export button.
4. Select the location where you would like to save the class list text (.txt) file and create
a filename. (MicroType 3.0 will automatically add a filename extension (.txt) to the
end of the filename.)
5. Click Save.
Making a Backup of Student Data
As you plan on how you will use the MicroType 3.0 software in your classroom, also
consider how you will backup your students performance data. If students save their
work on floppy disks, simply have them make a backup copy occasionally. If they use the
hard drive or network for storage, you should plan to backup the files at regular intervals.
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SECTION 5 GETTING STARTED WITH
MICROTYPE 3.0
This section includes the start-up instructions for the MicroType 3.0 software and
explains how to create a new student record. Student Preferences and the log in
procedures are discussed, too. Remind your students that they can access the on-line help
to learn more about the software.
IMPORTANT: Before students begin working with the MicroType 3.0 software,
review the information presented in Section 4Preparing to Use the Keyboarding Software on
page 13.
1. Turn on the computer.
2. Windows: Click on the Start button on the Taskbar and select Programs. Select the
South-Western Keyboarding program group and click MicroType 3.0. Macintosh: Locate the
MicroType 3.0 folder and open it. Double-click the MicroType 3.0 icon to start the
program.
3. Click anywhere on the splash screen to remove it and bring up the Log In dialog box.
4. Select the appropriate name from the list that appears in the Log In dialog box. Then,
enter the correct password to continue. Student should click the Guest button only if
directed by the teacher. (See Figure 5-1.)

Figure 5-1 Student Log In Dialog Box (Windows)
 When working from a floppy disk, click the Folder button and choose the floppy
disk drive. Select the appropriate name from the list and continue with the log in
process.
 Students using the program for the first time must click the New User button and
complete the New Student dialog box.
 If a students name does not appear in the list and the student already registered,
the student may have to use the Folder button to find performance data files.
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5. After a student logs in, the program will either display the Skill Analysis dialog box or
the Main menu or prompt the student to continue where he or she left off.
If the Main menu appears, the student should choose the appropriate keyboarding
module to display the lesson menu. A check mark appears next to each lesson that the
student completed, unless the student used the Guest option to log in. Check marks
also appear beneath the notebook tabs to show which exercises have been completed.
Note: You can choose the Preferences option in the Edit menu if you want to disable
the audio.
New Student Registration
When students first use the MicroType 3.0 program, they must enter the following
information: name, Class ID, and password. They must also identify where to store the
data. Have your students follow the appropriate instructions to register as a new user.
1. To register, click the New User button shown in the Log In dialog box. The New
Student dialog box appears. (See Figure 5-2.)

Figure 5-2 New Student Dialog Box
2. Enter user name (first name, last name).
3. Record the Class ID.
4. Enter a password. Be sure to write the password on a piece of paper and store it in a
safe place.
5. Specify the data location if necessary.
For example, the path may already be set to c:\program files\microtype3\
students (Windows) or MicroType 3.0: Students (Macintosh). If a student has his
or her own subdirectory, which was created previously, the student must set the path
accordingly [e.g., c:\program files\microtype3\students\lopez (Windows) or
MicroType 3.0: Students:Lopez (Macintosh)]. The student can click on the Folder
icon to browse through the directories to locate the folder.
6. Click the OK button to complete the registration process.
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Taking the Skill Analysis Timed Writing
After completing the New Student Registration, students will be prompted to take the
Skill Analysis timed writing. The Skill Analysis timed writing allows MicroType 3.0 to
evaluate your students keying ability prior to beginning the program. By taking this timed
writing, the program is able to recommend the lesson mode that matches your students
keyboarding ability. Each lesson mode is listed below.
New Key Learning mode: In the New Key Learning mode the animated character,
Typo, will introduce each key reach in the Alphabetic Keyboarding Learn (key) tabs. In
addition, each key reach is demonstrated by a realistic hand model. This mode is ideal for
new key learners or students who would like to review the key locations and key reach
demonstrations.
Refresher Mode: In the Refresher mode the key location and key reach demonstrations are disabled in the Alphabetic Keyboarding Learn (key) tabs. This mode is ideal for
students who are familiar with the key reaches and are already keying at 25 gwam or
higher.
Students should follow the instructions provided below to complete the Skill Analysis
timed writing.
1. Each time your students create a new student record, they will be prompted to take
the Skill Analysis timed writing. At the Skill Analysis welcome screen, click Yes or OK.
2. At the Skill Analysis instruction screen, click OK and begin keying the timed writing.
(The timing begins when a student keys the first character in the paragraph.) As
students key the writing the text will scroll at a pace that matches their keying speed.
The text will scroll only as fast as each student keys.
3. When time is up, the program will display the students gwam rate and number of
errors. Click OK, and then click the Print button to print the results or the Close
button to continue to the lessons.
4. When students have completed the Skill Analysis timed writing the program will
recommend a lesson mode (unless you, the teacher, disable this option).
5. Click OK to continue to the keyboarding lessons.
Your students can take the Skill Analysis timed writing again by clicking Skill
Analysis from the Edit menu. Repeating the Skill Analysis timed writing can help you
measure your students progress while working through MicroType 3.0. A Skill Analysis
summary report is available by clicking Summary Report from the Reports menu.
As a teacher, you can set the preferences for the Skill Analysis timed writing. You may
require that each student take the Skill Analysis timed writing before beginning the
lessons, set the timing length, and set the gwam and accuracy that students must achieve to
enter a lesson mode. In addition you may disable the Skill Analysis feature so that the
program does not recommend a lesson mode. Each of these preferences options is
available using Teacher Utilities. For a complete list of Skill Analysis preferences, see page
93.
NOTES:
1. Only the Learn (key) tabs in the Alphabetic Keyboarding section are affected by the
lesson mode settings. All other lesson parts are identical regardless of your lesson mode
setting.
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2. An icon or asterisk will appear on the Alphabetic Keyboarding lesson reports and
summary report next to each Learn (key) tab that the student completes in Refresher
mode.
3. If your students key above 45 gwam on the Skill Analysis test the program may
recommend that they spend time in the Keyboarding Skill Builder section where they
can build their speed and accuracy. Students who wish to continue in the Alphabetic
Keyboarding section despite the recommendation will automatically be set to
Refresher mode.
4. After completing the Skill Analysis timed writing, your students can change the lesson
mode unless you lock this option using Teacher Utilities.
Navigating the Main Menu
Click any of the four keyboarding titles shown on the Main menu to proceed directly
to the corresponding MicroType 3.0 keyboarding section. (See Figure 5-3.)
The Main menu also includes the following buttons on the left side of the screen
Help, Open Screen, Quick Review, Games, Movies, 3-D, and Exit.
Your students can always click the Help button to display on-line help information.
The Help button appears on almost every screen throughout the program. Whenever a
student needs assistance with a particular feature of the program, the on-line help is
always available.
Click the Open Screen button to access the built-in word processor. Using the Open
Screen, students can work to improve their keyboarding skills, take a timed writing, or
practice document formatting techniques. The Open Screen button appears on the Main
menu and on each lesson menu.
The Quick Review button allows your students to practice a particular technique
area. You can use the Quick Review option for pre-test and post-test measurements since
the program maintains the current and previous keying results.
The games in MicroType 3.0 provide fun ways for students to improve their keyboard-

Figure 5-3 Main Menu
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ing skills. Click the Games button to choose a game.
The movies discuss keyboarding issues and demonstrate various keyboarding techniques. Click the Movies button to select a movie. You can use the buttons below a
movie to pause the movie, or jump to the beginning or end of the movie. To exit the
movie, click the Back button.
MicroType 3.0 has 3-D viewers that let students interactively manipulate threedimensional keyboarding scenes. Click the 3-D button to access a viewer. Use the mouse
cursor or the arrow keys to rotate the scene.
Click the Exit button to exit the program. You can also quit the program by choosing
Exit from the File menu.
The Main menu also includes the Send File and Login buttons at the bottom of the
screen. MicroType 3.0 enables students in distance learning environments to have their
typing results checked. Click the Send File button to send a students data file to a
teacher for review. The Send File button also appears on each of the Lesson Report
screens (Windows only). Click the Login button to display the Log In dialog box.
Quick Review
The Quick Review section presents drill lines for students to key using the line-check
practice mode. If a student meets the accuracy requirement, the actual rate (orange) and
the goal rate (yellow) appear in the upper right corner of the notebook. The goal rate is
two gwam higher than the actual rate. The program challenges students to key the same line
at or above the goal rate (yellow). If a student meets or exceeds the goal, the new rate
appears in green. Otherwise, the program displays the gwam in red and prompts to try
again to reach the goal rate.
Access Quick Review from the Main menu by clicking the Quick Review button. The
Quick Review feature lets students practice their keyboarding skills for Alphabetic Keys,
Numeric Keys, Easy Lines, ENTER/RETURN, SPACE BAR, SHIFT Keys, CAPS
LOCK, and TAB Key.
The Quick Review Report displays the Average gwam for each section attempted. The
Report includes the date of the attempt, and lists information for both current and
previous attempts for each section. A BACKSPACE/DELETE icon appears next to the
sections that a student used the BACKSPACE/DELETE key. To print the report, click
the Print button in the lower right corner of the notebook. The Quick Review Report
will appear on screen. Click the Print button in the upper left corner to print.
NOTES:
1. The timer does not start until a student keys the first character in a drill line.
2. The indicator in the lower left corner of the notebook shows the status of the
BACKSPACE/DELETE key. If BACKSPACE/DELETE is disabled, an indicator
will appear in the lower left corner of the notebook.
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SECTION 6

ALPHABETIC KEYBOARDING

The Alphabetic Keyboarding consists of 20 lessons. Fifteen of the lessons teach the
alphabetic keys and basic punctuation keys at the rate of two keys per lesson (except
Lesson 1, which teaches ten keys). Five lessons, interspersed with the new-key lessons,
provide a reviewand a rest for learners.
Each lesson can be completed in approximately 20-25 minutes. On average, one
lesson should be completed each practice sessionin the sequence presented. Once keys
and techniques have been presented, they are used in the remaining lessons. Therefore,
skipping ahead forces the use of key reaches and techniques that have not yet been
presented.
Students may keep records of their performance data. (See Recording Student Performance Data on page 13.) The keyboarding software records which lessons or lesson parts
the student has completed as well as the speeds and keying lines for Build Skill activities.
Key Presentation
The lessons and the keys taught are listed as follows:
Lesson 1:
Learn Home Row
Lesson 2:
Review
Lesson 3:
Learn h and e
Lesson 4:
Learn i and r
Lesson 5:
Review
Lesson 6:
Learn o and t
Lesson 7:
Learn n and g
Lesson 8:
Learn Left Shift and (.)
Lesson 9:
Review
Lesson 10:
Learn u and c
Lesson 11:
Learn w and Right Shift
Lesson 12:
Learn b and y
Lesson 13:
Review
Lesson 14:
Learn m and x
Lesson 15:
Learn p and v
Lesson 16:
Learn q and (,)
Lesson 17:
Review
Lesson 18:
Learn z and (:)
Lesson 19:
Learn CAPS LOCK and (?)
Lesson 20:
Learn TAB and BACKSPACE/DELETE
Navigating Alphabetic Keyboarding
Learning to navigate the keyboarding software is very easy since students can perform
almost every option by simply clicking the buttons and controls that appear throughout
the program. Except for Reports, you really dont need to use the menu bar options.
All of the lessons in the Alphabetic Keyboarding section utilize the same navigation
techniques. Once your students work through a few lessons, they will have mastered most
of the softwares capabilities.
The students can click the Home button in the upper left corner of the screen to
return to the Main menu. (See Figure 6-1.) The Help and Open Screen buttons appear
below the Home button.
Section 6 Alphabetic Keyboarding
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Figure 6-1

Alphabetic Keyboarding Lesson Menu

To select a lesson from the Alphabetic Keyboarding Lesson menu, click the name of
the desired lesson.
The Back button appears on the Lesson menu and in every lesson part including the
game. Use this button to return to the previous level. Clicking the Back button here
goes back to the Main menu.
While working in a lesson, students can jump directly to any lesson part by clicking on
the corresponding tab that appears at the bottom of the notebook. (See Figure 6-2.)

Figure 6-2

Alphabetic Keyboarding (Lesson 3: Learn h and e)

The lesson tabs appear on the right side of the notebook while a student is working in
a lesson. The student can click on them to switch to a different lesson.
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Clicking the Back button from any lesson part takes you back to the Lesson menu.
If BACKSPACE/DELETE has been disabled using the Preferences menu, a BACKSPACE/DELETE key with a red circle appears in the lower left corner. With BACKSPACE/DELETE disabled, a student cannot use the BACKSPACE/DELETE key in the
lesson activity.
The Forward button appears on the Key-A-Shot game console. Click this button to
continue with the next lesson part (i.e., Lesson Report). The Forward button appears
only on the game screens in the various keyboarding lessons.
The Send File button appears on the Lesson Report screen (Windows only). See
Figure 6-3. Click this button to send the student data file to a teacher for review. Click
the Print button to print the report. Click the Graph button to view the Performance
Graph. If you click the Back button here, you return to the lesson menu.

Figure 6-3

Alphabetic Keyboarding (Lesson Report)

Lesson Design
Beginning with Lesson 3, each new-key lesson reviews previous learning (Conditioning
Practice), introduces two or more new keys (Learn Key), provides practice on the new
keys (Combine Keys), provides practice on specific reaches and techniques (Improve
Keystroking), helps students develop fluency (Build Skill), and encourages students to
practice by playing Key-A-Shot (Game). Review lessons consist of Conditioning Practice,
Improve Keystroking, Build Skill, and Key-A-Shot (Game).
After the student selects a lesson, the program displays a notebook with the first
learning activity. The highlighted (tan) tab at the bottom of the notebook indicates the
current lesson activity. Each lesson part is labeled. If a student partially completes a
lesson, he/she should select the appropriate lesson and then click the corresponding
notebook tab to continue where he/she left off.
Conditioning Practice
The Conditioning Practice lesson part provides the opportunity for your students to
practice their keyboarding skills prior to learning new keys. As illustrated in Figure 6-4,
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technique hints and photos provide tips that will help students improve their keyboarding
skill.
Students key each drill line once for practice and a second time for speed. The
program shows a students speed in gross words a minute (gwam) after the second attempt.
Students must key each line at an acceptable accuracy rate; otherwise, the program
indicates that there are too many errors and requires the student to repeat the line.
MicroType 3.0 uses the line-check practice mode in this lesson part. The minimum
accuracy requirement is set at 50%, but you can change this setting by changing the
Preferences using the teacher utilities. (See page 89.)
Depending on the keyboarding Preferences, the program may or may not allow
students to use the BACKSPACE/DELETE key in this lesson part. Students cannot use
the BACKSPACE/DELETE key if the BACKSPACE/DELETE icon with the red circle
appears in the lower left corner of the notebook.

Figure 6-4

Alphabetic Keyboarding (Conditioning Practice)

Learn Key
The Learn Key lesson part reinforces proper keyboarding posture, identifies the
location of the new key, shows which finger to use, demonstrates the proper key reach,
and lets students practice the new key reach. (See Figure 6-5.) Drill lines are presented
using the lock-and-flash practice technique.
Movies Occasionally in the Learn Key lesson part, a movie emphasizing office
ergonomics or correct key reaching will be presented. Use the Rewind, Pause, and Fast
Forward keys to control the movie. Strike Enter to end the movie. The movies are also
available from the Main menu by clicking on the Movies button. Teachers and students can
disable the lesson movies using the Preferences option.
3-D Viewer Following some of the movies, a 3-D viewer is presented. Using the 3D viewer, students can rotate models to view proper posture and hand positioning. Use
the cursor hand or the cursor keys to rotate the model. Strike Enter to close the 3-D
viewer. The 3-D viewer is also available from the Main menu by clicking on the 3-D
button. Teachers and students can disable the lesson 3-D viewer using the Preferences
option.
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Figure 6-5

Alphabetic Keyboarding (Learn Key)

NOTES:
1. The BACKSPACE/DELETE key is always disabled in this lesson part and does not
appear on the notebook regardless of the Preferences setting.
2. If the Alphabetic Keyboarding lesson mode is set to Referesher Mode, only the movies
and drill lines will be presented. Change the lesson modes by using the Preferences
option in the Edit menu.
Combine Keys
After your students learn new keys, the Combne Keys lesson part presents drill lines
that reinforce those two keys. (See Figure 6-6.) The drill lines, which are presented
using the word-flash method, also include keys from previous lessons. While keying a drill
line, remind students to strike the SPACE BAR after each word or letter.
NOTE: The BACKSPACE/DELETE key is always disabled in this lesson part and
does not appear on the notebook regardless of the Preferences setting.
Improve Keystroking
The Improve Keystroking lesson part provides practice on specific reaches and
techniques. The MicroType 3.0 software presents the drill lines using a word-lock
approach. The number of drill lines in this part varies from lesson to lesson.
Technique hints and photos provide tips that help students improve their keyboarding
skill. The emphasis for the drill line also appears as a reference. (See Figure 6-7.) Divider
marks | may appear in some drill lines. The dividers identify word groups that include
two or more words that students should key together as a unit.
NOTE: The BACKSPACE/DELETE key is always disabled in this lesson part and
does not appear on the notebook regardless of the Preferences setting.
Build Skill
The Build Skill lesson part emphasizes increasing students keying speed. (See Figure 68.) The program presents drill lines for students to key using the line-check practice mode.
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Figure 6-6

Alphabetic Keyboarding (Combine Keys)

If a student meets the accuracy requirement, the program shows the actual rate (orange)
and the goal rate (yellow) in the upper right corner of the notebook. The goal rate is two
gwam higher than students actual rate.
The MicroType 3.0 program challenges students to key the same line at or above the
goal rate (yellow). If a student meets or exceeds the goal, a new rate appears in green.
Otherwise, the program displays the gwam in red and asks the student if he/she wants to
try again to reach the goal rate.
If a student keys the line with too many errors, the program does not display the
speed. Rather, it instructs the student to key the line again. If the second attempt also
has too many errors, the program presents the next drill line.

Figure 6-7
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Figure 6-8

Alphabetic Keyboarding (Build Skill)

For the Build Skill lesson part, the program records the following information:
Average speed Drill lines must meet or exceed the accuracy requirement to be included
in the average-speed calculation.
Fastest speed

The fastest speed is based on all of the drill lines in this lesson part.

Drill lines

The program stores the last attempt for each drill line in the lesson part.
If a student chooses to print the Lesson Report, the original copy and
the actual drill lines keyed appear on the report.

Divider marks | may appear in some drill lines. The dividers identify word groups
that include two or more words that students should key together as a unit.
NOTES:
1. The timer does not start until a student keys the first character in a drill line.
2. If the BACKSPACE/DELETE key is disabled, an icon with a red circle appears in the
lower left corner of the notebook.
3. MicroType 3.0 stores only the most recent keying information if a student completes
this lesson part more than once.
Game (Key-A-Shot)
The object of the Key-A-Shot game is for your students to shoot as many balls as they
can through the hoop by keying quickly and accurately. Points are earned for each shot
they make. By playing the Key-A-Shot game, students can have fun while improving their
keyboarding skill. (See Figure 6-9.)
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Figure 6-9

Alphabetic Keyboarding (Key-A-Shot)

Beginning a New Game The gwam goal for a game is approximately 90% of the
average speed that a student attained in the Alphabetic Keyboarding Build Skill lesson
parts. If a student did not complete the Build Skill lesson part, the program uses the goal
specified in the preferences dialog box.
The score area to the right of the screen shows the following information: Score, gwam
rate, gwam goal
As students play the game, a basketball is shot toward the hoop each time they key a
word correctly. If they key the word at or above their gwam goal, they will make the shot
and earn two points. If students key a word below their gwam goal, or inconsistently, they
will miss the shot. Students should always key each drill line as quickly and accurately as
possible. Remind them to strike the ENTER/RETURN key at the end of each drill line.
If students make too many errors in a drill line, their gwam rate will not be included in the
final results.
Delayed vs. Real-Time Mode Students can play the game in delayed mode or in
real-time mode. (See the Preferences option.) In delayed mode, the action occurs after a
student key the entire drill line and strikes ENTER/RETURN.
Playing the game in real-time mode can be more challenging because it forces students
to focus on each drill line. As soon as a student keys a word correctly, the corresponding
basketball is shot toward the hoop. Remind your students to try and concentrate on the
drill lines when playing Key-A-Shot in real-time mode.
Earning Points When playing Key-A-Shot, students earn 2 points for each basket
they make. Students earn 20 bonus points for making all of the shots by keying the drill
line accurately and meeting or exceeding their gwam goal. Students earn 10 bonus points
for keying with 100% accuracy but below their gwam goal.
The MicroType 3.0 software keeps a list of the top ten scores for the Key-A-Shot game.
Select the TopTen Lists option in the Reports menu to display the list.
Game Over The game ends after a student keys all of the drill sets. The program
displays the goal speed, average speed, fastest speed, and total score. This information also
appears on the Lesson Report. If students play the game more than once, MicroType 3.0
stores only the most recent score for each lesson.
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Playing the Game Outside of the Lessons The Key-A-Shot game is available
outside of the lessons by clicking on the Games button from the Main menu. The drill
lines presented in the Key-A-Shot game outside of the lessons contain all of the
alphabetic key reaches; therefore, students should not begin using the Key-A-Shot game
outside of the lessons until they have completed the Alphabetic Keyboarding lessons.
The gwam goal is approximately 90% of the average speed that a student attained in all
of the Build Skill parts completed in the Alphabetic Keyboarding lessons. If a student did
not complete a Build Skill part, the program uses the Alphabetic Keyboarding goal
specified in the Preferences.
NOTES:
1. The BACKSPACE/DELETE preference (on or off) used in the Alphabetic Keyboarding lesson also applies to the Key-A-Shot game.
2. Students must set the preferences before beginning a new game.
3. A teacher option may be used to deny access to any of the games.
Lesson Report
The Lesson Report shows the performance for each lesson. (See Figure 6-10.) When a
student completes the Conditioning Practice, Learn Key, Combine Keys, or Improve
Keystroking part, a check mark appears next to that item on the report. In addition, the
Lesson Report includes the average and fastest speeds for both the Build Skill part and the
Key-A-Shot game. The drill lines keyed in the Build Skill section appear on the printed
report. The goal speed and total score for the game appear on the report, too.

Figure 6-10

Alphabetic Keyboarding (Lesson Report)

A BACKSPACE/DELETE icon appears next to a lesson part if a student used the
BACKSPACE/DELETE key. A refresher mode icon appears next to each Learn Key
lesson part of the student completed the lesson part in Refresher Mode. The student can
click the Send File button (Windows only) to send the data file to you for review (see
Section 6 Alphabetic Keyboarding
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Section 13). To print the report, click the Print button in the lower right corner of the
notebook. The Lesson Report will appear on screen. Click the Print button in the upper
left corner to print. Click the Graph button to view the Performance Graph. A blue box
appears around the number of the current lesson on the graph.
Preferences
By setting Preferences, you can control the following aspects of the Alphabetic
Keyboarding section. Only those items marked with an asterisk (*) can be changed by
students. The teacher-controlled options do not appear in the Preferences dialog box that
your students can access. However, you may change any of these items by using the
teacher utilities.
Students may access their personal keyboarding options by choosing the Preferences
option from the Edit menu. The Preferences are categorized by section. To change an
option, instruct your students to simply click the corresponding option. If a category is
locked, students may not change any of the options for that section.
General Preferences

Alphabetic Keyboarding Preferences

 Show lesson movies*

 Accuracy rate (50%)

 Play movie audio *

 BACKSPACE/DELETE allowed*

 Play narration/effects Audio *

 Game goal (15 gwam)

 Use Bookmark *

 Game drill lines (6)

 Allow game access

 Game Delayed Action*

 Allow students to change password  Automatically select lesson mode
 Two spaces after end punctuation*  Leson Mode (New key learning/
Refresher)*
 Create sub-folder for each student
 Language (English/Spanish)*
 Teacher Email Address*
Teaching Suggestions
The following are several teaching suggestions that may be helpful as your students
begin working with the Alphabetic Keyboarding section of the MicroType 3.0 software.
1. The BACKSPACE/DELETE key is available for drills that use the line-check
processing method and in the Open Screen. You control the status by setting the
corresponding Preferences option. It is recommended that you not make the BACKSPACE/DELETE key available before students complete Lesson 8. During initial
learning, students should focus on technique to build fluent keystroking.
The BACKSPACE/DELETE key is introduced in Alphabetic Keyboarding, Lesson 20.
Before you make BACKSPACE/DELETE available to students, it is recommended
that they complete the Learn Backspace tab.
2. Before students begin Lesson 1, have them use the Open Screen while you demonstrate body position, hand placement, and introduction of the home-row keys, SPACE
BAR, and ENTER/RETURN. The Open Screen will be less likely than the lesson
screens to distract students attention from you. Once you have completed your
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introduction, instruct your students to close the Open Screen window and complete
Lesson 1.
Similarly, for any live portions of any lesson, have the students use the Open Screen
so that what you are telling them to do will not conflict with the instructions they see
on the screen.
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SECTION 7

NUMERIC KEYBOARDING

The Numeric Keyboarding consists of 16 lessons. The lessons teach the figure keys
and symbols/punctuation keys at the rate of two keys per lesson (except Lesson 15). A
review lesson appears after students learn all of the top-row figures and symbols.
Each lesson requires approximately 20-25 minutes. On average, one lesson should be
completed each practice session. Keys learned in early lessons are reused systematically in
later lessons. Therefore, instruct students to complete the lessons in the appropriate
sequence.
Key Presentation
The lessons and the keys taught are listed as follows:
Lesson 1:
Learn 8 and 1
Lesson 2:
Learn 9 and 4
Lesson 3:
Learn 0 and 5
Lesson 4:
Learn 7 and 3
Lesson 5:
Learn 6 and 2
Lesson 6:
Review
Lesson 7:
Learn / and $
Lesson 8:
Learn % and Lesson 9:
Learn # and &
Lesson 10:
Learn ( and )
Lesson 11:
Learn  and 
Lesson 12:
Learn _ and *
Lesson 13:
Learn @ and +
Lesson 14:
Learn ! and \
Lesson 15:
Learn = and [ ]
Lesson 16
Learn > and <
Navigating Numeric & Skill Keyboarding
All of the lessons in the Numeric Keyboarding section utilize the same navigation
techniques. The buttons and other control features in this section are almost identical to
the Alphabetic Keyboarding section. For a more detailed description, see the Navigating
Alphabetic Keyboarding on page 25.
The students can click the Home button to return to the Main menu. (See Figure 71.) The Help and Open Screen buttons appear below the Home button.
To select a lesson from the Numeric Keyboarding Lesson menu, click the name of the
desired lesson.
The Diagnostic Writings button allows students to access the Diagnostic Writings
feature. This feature can be used to evaluate students performance using a variety of
writings. See page 55 for more details.
The Back button appears on the Lesson menu and in every other lesson part including
the game. Students can use this button to return to the previous menu. Clicking the
Back button here goes back to the Main menu.
Lesson Design
Each new-key lesson reviews previous learning (Conditioning Practice), introduces
two new keys (Learn Key), provides practice on the new keys (Combine Keys), provides
practice on specific reaches and techniques (Improve Keystroking), helps students develop
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fluency (Build Skill), and provides a skill-building game (Connect It). The review lesson
consists of Conditioning Practice, Improve Keystroking, Build Skill, and Game.

Diagnostic Writings
Back

Figure 7-1

Numeric Keyboarding Lesson Menu

After a student selects a lesson, the program displays a notebook with the first learning
activity. The highlighted (tan) tab at the bottom of the notebook indicates the current
lesson activity. Each lesson part is labeled. If a student partially completes a lesson, he/
she should select the appropriate lesson and then click the corresponding notebook tab to
continue working with the software.
Conditioning Practice
Conditioning Practice provides the opportunity for your students to practice their
keyboarding skills prior to learning new keys. As illustrated in Figure 7-2, technique hints
and photos provide tips that will help students improve their keyboarding skill.

Figure 7-2

Numeric Keyboarding (Conditioning Practice)
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Students key each drill line once for practice and a second time for speed. The
program shows a students speed in gwam after the second attempt. Students must key the
drill lines at an acceptable accuracy rate; otherwise, the program indicates that there are
too many errors and requires the student to repeat the line. MicroType 3.0 uses the linecheck practice mode in this lesson part. The minimum accuracy requirement is set at
50%, but you, the teacher, can change this setting by using the Preferences option in the
teacher utilities. (See page 89.)
Depending on the keyboarding Preferences, the program may or may not allow
students to use the BACKSPACE/DELETE key in this lesson part. Students cannot use
the BACKSPACE/DELETE key if the BACKSPACE/DELETE icon with the red circle
appears in the lower left corner of the notebook.
Learn Key
The Learn Key lesson part reinforces proper keyboarding posture, identifies the
location of the new key, shows which finger to use, demonstrates the proper key reach,
and lets students practice the new key reach. (See Figure 7-3.) Drill lines are presented
using the lock-and-flash practice technique.

Figure 7-3

Numeric Keyboarding (Learn Key)

Movies Occasionally in the Learn Key lesson part, a movie emphasizing office
ergonomics or correct key reaching will be presented. Use the Rewind, Pause, and Fast
Forward keys to control the movie. Strike Enter or click the Exit button to end the
movie. The movies are also available from the Main menu by clicking on the Movies
button. Teachers and students can disable the lesson movies using the Preferences option.
3-D Viewer Following some of the movies, a 3-D viewer is presented. Using the 3D viewer, students can rotate models to view proper posture and hand positioning. Use
the cursor hand or the cursor keys to rotate the model. Strike the Enter button to close
the 3-D viewer. The 3-D viewer is also available from the Main menu by clicking on the
3-D button. Teachers and students can disable the lesson 3-D viewer using the Preferences
option.
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Combine Keys
After your students learn new keys in each lesson, the Combine Keys lesson part
presents drill lines that reinforce those two keys. The drill lines, which use either the
word-lock or the word-flash method, also include keys from previous lessons. While
keying a drill line, remind students to strike the SPACE BAR after each word or letter.
(See Figure 7-4.)

Figure 7-4

Numeric Keyboarding (Combine Keys)

NOTE: The BACKSPACE/DELETE key is always disabled in this lesson part and
does not appear on the notebook regardless of the Preferences setting.
Improve Keystroking
The Improve Keystroking lesson part provides practice on specific reaches and
techniques. The MicroType 3.0 software presents the drill lines using a word-lock
approach. The number of drill lines in this part varies from lesson to lesson.
Technique hints and photos provide tips that help students improve their keyboarding
skill. The emphasis for the drill line also appears. (See Figure 7-5.) Divider marks |
may appear in some drill lines. The dividers identify word groups that include two or
more words that students should key together as a unit.
NOTE: The BACKSPACE/DELETE key is always disabled in this lesson part and
does not appear on the notebook regardless of the Preferences setting.
Build Skill
In the Numeric Keyboarding section, this lesson part helps student build their
keyboarding speed by using two different Build Skill activities. A lesson may contain
either a Build SkillSentences or a Build SkillParagraphs activity.
Build SkillSentences The Build SkillSentences lesson part emphasizes
building speed. The program presents drill lines for students to key using the line-check
practice mode. If a student meets the accuracy requirement, the program shows the
actual rate (orange) and the goal rate (yellow) in the upper right corner of the notebook.
The goal rate is two gwam higher than the students actual rate.
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Figure 7-5

Numeric Keyboarding (Improve Keystroking)

The MicroType 3.0 program challenges students to key the same line at or above the
goal rate (yellow). If a student meets or exceeds the goal, a new rate appears in green.
Otherwise, the program displays the gwam in red and asks the student if he/she wants to
try again to reach the goal rate.
If a student keys the line with too many errors, the program does not display the
speed. Rather, it instructs the student to key the line again. If the second attempt also
has too many errors, the program presents the next drill line.
For the Build SkillSentences lesson part, the program records the following
information:
Average speed Drill lines must meet or exceed the accuracy requirement to be
included in the average-speed calculation.
Fastest speed

The fastest speed is based on all of the drill lines in this part.

Drill lines

The program stores the last attempt for each drill line in the lesson
part. If a student chooses to print the Lesson Report, the original
copy and the actual drill lines keyed appear on the report.

Divider marks | may appear in some drill lines. The dividers identify word groups
that include two or more words that students should key together as a unit.
NOTES:
1. The timer does not start until a student keys the first character in a drill line.
2. If the BACKSPACE/DELETE key is disabled, an icon with a red circle appears in the
lower left corner of the notebook.
3. MicroType 3.0 stores only the most recent keying information if a student completes
this lesson part more than once.
Build SkillParagraphs The Build SkillParagraphs part presents paragraphs for
students to key using a modified version of the line-check practice mode. (See Figure 76.) Instruct your students to key the entire paragraph as quickly as possible. If a student
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meets the accuracy requirement, the program shows the actual rate (orange). Before a
student keys the paragraph again, the goal rate (yellow) appears on the screen. The goal
rate is two gwam higher than the students actual rate.
While keying a paragraph, remind students not to strike ENTER/RETURN at the end
of each line since the program has a built-in word wrap feature. Strike ENTER/
RETURN only at the end of a paragraph to finish the timed writing.
The MicroType 3.0 program challenges your students to key the same paragraph at or
above the goal rate (yellow). If a student meets or exceeds the goal, the new rate appears
in green. Otherwise, the program displays the gwam in red and asks the student to try again
to reach the goal rate.
If a student keys too many errors, the program does not display the students speed.
Rather, it instructs the student to key the paragraph again. If the second attempt also has
too many errors, the program presents the next paragraph.

Figure 7-6

Numeric Keyboarding

(Build SkillParagraphs)

For the Build SkillParagraphs lesson part, the program records the following
information:
Average speed A paragraph must meet or exceed the accuracy requirement to be
included in the average-speed calculation.
Fastest speed

The fastest speed is based on all of the paragraphs in this lesson
part.

Paragraphs

The program stores the last attempt for a paragraph. If a student
chooses to print the Lesson Report, the original copy and the actual
paragraphs keyed appear on the report.

NOTES:
1. The timer does not start until a student strikes the TAB key.
2. If the BACKSPACE/DELETE key is disabled, an icon with a red circle appears in the
lower left corner of the notebook.
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3. MicroType 3.0 stores only the most recent keying information if a student completes
the lesson part more than once.
Game (Connect It)
Beginning a New Game The object of the Connect It game is to clear the game
boardby clicking matching pairsbefore time runs out. (See Figure 7-7.) To earn the
maximum amount of game time (and a chance to earn the highest possible score for the
game) students must key each drill line at or above their gwam goal with 100% accuracy.
Keying below their gwam goal, or with errors, will earn less game timeand, consequently, a lower score.

Figure 7-7

Numeric Keyboarding (Connect It)

The gwam goal for a game equals 90% of the average speed that the student attained
in the Numeric Keyboarding Build Skill lesson parts or it is set by a teacher preference if
the student did not complete the Build Skill part. If the student accesses the Connect It
game from the Main Menu rather than the lesson tab, the gwam is approximately 90% of
the average speed that was attained in all the Build Skill parts.
Students key each line as quickly and accurately as possible, being sure to strike
ENTER/RETURN at the end of a drill line. If students key a word incorrectly or do not
meet their gwam goal, they earn less game time.
As students complete the drill lines, game pieces are revealed. After all drill lines are
complete, students should strike ENTER/RETURN to complete the game board and
begin the game. The count-down timer begins as soon as students strike ENTER/
RETURN.
Playing the Game The object of Connect It is to clear the game board before time
runs out. To do so, students make pairs of images disappear by clicking matching images
that can be connected with a straight line using 2 or fewer right angles. (See Figure 7-8.)
Clear a path between matching diagonal images to link them. Look for matching images
along the outside of the grid. Points are earned for each pair of images that students
clear. Bonus points are awarded for each second that remains when students clear the
board.
42

MicroType 3.0 Users Guide

Figure 7-8

Connect It Game Board

Advancing Levels Each time students clear the game board before time runs out
they will advance to a new level. After completing two levels, students will receive a
more challenging game board. (For example, students will receive a new game board on
levels 3, 5, 7, etc.). If students are having difficulty advancing to a new level, you can
allow the students to earn more game time by increasing the amount of time they earn for
completing each drill line. To do so, access Teacher Utilities and click the Numeric tab.
Increase the number of seconds earned per drill line in the max seconds earned per line
field.
Earning Points When students play Connect It, they earn 100 points for each pair
of images that they clear. In addition, students earn 50 points for each second that
remains when they clear the board.
Connect It keeps a list of the top ten scores for each level in the game. Select the Top
Ten Lists option in the Reports menu to display the list.
Game Over The game ends when students clear the game board or when time runs
out. The program displays their total score, fastest speed, average speed, and goal speed.
This information also appears on the Lesson Report. If students key the drill lines in
Connect It more than once in a single lesson, MicroType 3.0 stores the most recent score.
Playing the Game Outside of the Lessons (Connect It) The Connect It game is
available outside of the lessons by clicking on the Games button from the Main menu.
The drill lines presented in the Connect It game outside of the lessons contain all of the
alphabetic key reaches; therefore, students should not begin using the Connect It game
outside of the lessons until they have completed the Alphabetic Keyboarding lessons.
The gwam goal is approximately 90% of the average speed that a student attained in all
of the Build Skill parts completed in the Numeric Keyboarding lessons. If a student did
not complete a Build Skill part, the program uses the Numeric Keyboarding goal specified
in the Preferences.
NOTES:
1. The BACKSPACE/DELETE preference (on or off) for Numeric Keyboarding also
applies to the Connect It game available from the Games Menu.
2. Students must set the preferences before beginning a new game.
3. A teacher option may be used to deny access to any of the games.
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Lesson Report
The Lesson Report shows the performance for each lesson. (See Figure 7-9.) When a
student completes the Conditioning Practice, Learn Key, Combine Keys, or Improve
Keystroking part, a check mark appears next to that item on the report. In addition, the
Lesson Report includes the average and fastest speeds for both the Build Skill part and the
Connect It game. The drill lines and paragraphs keyed in the Build Skill section appear on
the printed report. The goal speed and total score for the game appear on the report, too.

Figure 7-9

Numeric Keyboarding (Lesson Report)

A BACKSPACE/DELETE icon appears next to a lesson part if a student used the
BACKSPACE/DELETE key. The student can click the Send File button to send the
data file to a teacher for review. To print the report, click the Print button in the lower
right corner of the notebook. The Lesson Report will appear on screen. Click the Print
button in the upper left corner to print. Click the Graph button to view the Performance
Graph. A blue box appears around the number of the current lesson on the graph.
Preferences
By setting Preferences, you can control the following aspects of the Numeric & Skill
Keyboarding section. Only those items marked with an asterisk (*) appear in the student
Preferences window. The teacher-controlled options do not appear in the Preferences
dialog box that your students can access. However, you may change any of these items by
using the teacher utilities. Refer to the instructions beginning on page 89.
Students may access their personal keyboarding options by choosing the Preferences
option from the Edit menu. The Preferences are categorized by section. To change an
option, instruct your students to simply click the corresponding option. If a category is
locked, students may not change any of the options for that section.
General Preferences
 Show lesson movies*
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 Play movie audio *

 Backspace allowed*

 Play narration/effects Audio *

 Game goal (15 gwam)

 Use Bookmark *

 Game drill lines (6)

 Allow game access

 Max seconds earned per line (30)

 Allow students to change password
 Two spaces after end punctuation*
 Create sub-folder for each student
 Language (English/Spanish)*
 Teacher Email Address*
Teaching Suggestions
Students will have to pivot their hands forward slightly to reach the top-row figure
and symbol keys. Thus, reaches to figures and symbols will involve more hand motion
than any of the alphabetic key reaches. As much finger-action as possible, though, should
be retained. Fingers should be returned to the home-key position following each reach so
that home-row orientation is not lost. Be sure to observe (and if necessary correct) this
technique in the early lessons.
Students likely will have to adjust their speed when keying copy that includes figures
and symbols. They should be encouraged to speed up for easy copy and slow down for
figures and symbols. All copy should be keyed continuously, however. Pauses before
reaching to a figure/symbol key should be avoided. The Technique Check Sheet (Appendix B) may be used in observing and evaluating students techniques.

Section 7 Numeric Keyboarding

45

SECTION 8

KEYBOARDING SKILL BUILDER

The MicroType 3.0 Keyboarding Skill Builder section includes 20 lessons of increasing
difficulty that help students build keying speed and improve control. Students can also
access the Diagnostic Writings features to analyze their progress.
Review the information presented in this section to help your students get the most
from the Keyboarding Skill Builder lessons. You will find information on navigating the
software, lesson design, diagnostic writings, etc. Students should know all reaches before
they begin this section.
Navigating Keyboarding Skill Builder
All of the lessons in the Skill Builder section utilize the same navigation techniques.
Once your students work through a few lessons, they will have mastered most of the
softwares capabilities. If your students are continuing from another section, they should
already be familiar with how the program operates. (See Figure 8-1.)

Diagnostic Writings
Back

Figure 8-1

Keyboarding Skill Builder Lesson Menu

The students can click the Home button to return to the Main menu. The Help and
Open Screen buttons appear below the Home button.
To select a lesson from the Keyboarding Skill Builder Lesson menu, click the name of
the desired lesson.
The Back button appears on the Lesson menu and in every other lesson part including
the game. Students can use this button to return to the previous level. Clicking the Back
button here goes back to the Main menu.
The Diagnostic Writings button also appears on the lesson menu. It allows students
to access the Diagnostic Writings feature. This feature can be used to evaluate students
performance using a variety of writings. See page 55 for more details.
While working in a lesson, students can jump directly to any lesson part by clicking on
the corresponding tab that appears at the bottom of the notebook.
NOTE: Students can hold down the ALT key and strike the underlined letter shown
on the tab (Windows only).
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The lesson tabs appear on the right side of the notebook in the lessons. Students can
click on them to switch to a different lesson. Clicking the Back button from any lesson
part takes you back to the Lesson menu.
The BACKSPACE/DELETE icon shows the current status of the BACKSPACE/
DELETE key determined by the keyboarding Preferences. The BACKSPACE/DELETE
key is disabled if an icon with a red circle appears in the lower left corner of the
notebook. In some activities, BACKSPACE/DELETE is always disabled. The BACKSPACE/DELETE icon will not appear in these activities.
The Forward button appears on the Mystery Puzzle game console. Click this button
to continue with the next lesson part (i.e., Lesson Report). The Forward button appears
only on the game screens in the various keyboarding lessons.
The Print button appears on the Lesson Report screen. Click this button to print the
report. The Lesson Report will appear on screen. Click the Print button in the upper left
corner to print. Click the Graph button to view the Performance Graph. Click the Back
button to return to the Lesson menu.
Lesson Design
The program offers twenty lessons. Each 20- to 25-minute lesson can be completed
with an emphasis on speed or accuracy. Prior to selecting a lesson, students may select the
emphasis from the Preferences option in the Edit menu. Students should NOT change the
emphasis partway through a lesson. Work done in a lesson part with one emphasis selected
will not appear on the Lesson Report for the same lesson if the other emphasis is picked.
The current emphasis appears on the lesson menu. Because of differences in copy
difficulty, the lessons should be completed in sequence, one lesson per practice session.
The Mystery Puzzle game is closely linked with student performance in the
Keyboardng Skill Builder section. Students earn game chances as they work through a
lesson. Additional chances are awarded for completing each lesson part and for working
to improve speed and accuracy.
Sentences and paragraphs consist of controlled copy. Sentences are controlled for
difficulty in terms of handedness: balanced-hand (easy) and one-hand (not so easy).
Paragraphs are triple controlled (i.e., syllable intensity, word length, and percentage of
high-frequency words). Copy in the lessons is arranged in simple-to-complex order.
Lessons A-E contain only balanced-hand words (VERY EASY) .
Lessons F-L contain balanced- and near-balanced-hand words (EASY). A nearbalanced-hand word is balanced-hand except for just one 2-letter combination keyed by a
single hand. Such words are fairly easy to key and are much more numerous than strictly
balanced-hand words and thus offer greater practice variety.
Lessons M-T contain a mix of balanced- and one-hand words. A number of short
one-hand words, such as on, in, at, are used often in typical communication and should be
practiced heavily. Thus, such words can be keyed rapidly, continuously during timepressure writings (as in paragraphs). Note, though, that the one-hand words are not
limited to those of only two or three letters; some longer words from the high-frequency
list are also used.
The paragraph copy used in the lessons gets progressively more difficult. In Lessons AE, all paragraphs are triple controlled at the EASY level. All letters of the alphabet are
used in the two paragraphs combined.
In Lessons F-K, all paragraphs are EASY; but in Lesson L the difficulty level is LOW
AVERAGE to give students at least a bit of a challenge. All letters are used in the two
paragraphs combined.
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In Lessons M-T, all paragraphs are of LOW AVERAGE difficulty. All letters are used
in the paragraphs of each set.
This progression in copy difficultyas well as in line length (50-space lines in Lessons
A-E; 60-space lines in Lessons F-L; 65- and 70-space lines in Lessons M-T) parallels
progression in the textbook with which Keyboarding Skill Builder is likely to be used.
Keyboard Mastery
The Keyboard Mastery lesson part provides a warm-up. (See Figure 8-2.) The
MicroType 3.0 software presents the first line using the word-lock method, the second drill
line based on word-flash, and the last two lines using the line-check technique. The
BACKSPACE/DELETE key is not available when students key the first two lines, but
may be available for the last two lines depending on the current setting in Preferences.
NOTES:
1. The presentation of the drill lines in this lesson part is not affected by the speed or
accuracy emphasis.
2. Students earn two game chances for completing this lesson part.

Figure 8-2

Keyboarding Skill Builder (Keyboard Mastery)

Improve Technique
The Improve Technique lesson part provides practice on specific reaches and techniques. (See Figure 8-3.) The MicroType 3.0 software presents the drill lines using a wordlock approach. Usually, this lesson part includes six drill lines.
Divider marks | may appear in some drill lines. The dividers identify word groups
that include two or more words that students should key together as a unit.
Technique hints and photos provide tips that help your students improve their
keyboarding skill. The emphasis for the drill line also appears for their reference.
NOTES:
1. The BACKSPACE/DELETE key is always disabled in this lesson part and does not
appear on the notebook regardless of the Preferences setting.
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2. The presentation of the drill lines in this lesson part is not affected by the speed or
accuracy emphasis.
3. Students earn two game chances when they complete the Improve Technique activity.

Figure 8-3

Keyboarding Skill Builder (Improve Technique)

Sentences
The Sentences lesson part of the Skill Builder section is presented differently depending on whether students chose to emphasize speed or accuracy. The emphasis is set by
using the Preferences option.
Speed With the emphasis set to speed, this lesson part provides practice for
increasing speed on repeated copy. (See Figure 8-4.) To establish a base keying rate,
students must key a one-line sentence as many times as possible in a fixed time period (30
seconds or one minute). Then, if the work is acceptably correct, the program challenges
students to increase their speed by two gwam for the same sentence. When a student
meets the goal, the program sets a new goal two gwam higher than the rate just keyed.
Students can continue trying to meet goals on a sentence as many times as they want.
The program displays the initial rate for a sentence in orange. Then, the goal rate is
shown in yellow. If a student meets the goal, the rate is shown in green; otherwise, it
appears in red.
When students choose to go on to the next sentence, the program computes the
average speed for the preceding sentence and uses that average as the initial gwam goal for
the new sentence. The program applies this same procedure to each of the remaining
sentences in this part.
Accuracy With an accuracy emphasis, the Sentences lesson part provides practice
for improving control on repeated copy. (See Figure 8-5.) To improve control, students
key a one-line sentence for a fixed time period (30 seconds or one minute). Instruct them
to key the sentence at a brisk pace (not the fastest speed) while making no more than six
errors. When the time has elapsed, MicroType 3.0 displays the speed, identifies the number
of errors, and highlights the errors. The MicroType 3.0 program identifies missing words or
tabs, error words, extra words, and transposed words.
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Figure 8-4

Keyboarding Skill Builder (SentencesSpeed)

Figure 8-5

Keyboarding Skill Builder (SentencesAccuracy)

If students make six or fewer errors, the program challenges them to key the sentence
again with even fewer errors. If they key the sentence with no errors, the program asks if
they want to try again for zero errors at or above the last speed. Students can repeat each
sentence an unlimited number of times. When they choose to go on to the next sentence,
the program sets the initial goal back to six or fewer errors. This lesson part includes four
sentences.
NOTES:
1. Students may enable or disable the BACKSPACE/DELETE key for Sentences with a
speed emphasis.
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2. The BACKSPACE/DELETE key is always turned off regardless of the setting when
the emphasis is set to accuracy.
3. An optional count-down timer may be activated for this lesson part by using the
Preferences option.
4. During the error analysis, the program assumes a maximum of one error per incorrect
word.
5. The program assigns two additional game chances each time a student meets the next
higher goal on a sentence.
Paragraphs
The activities for the two paragraphs in this lesson part vary depending on whether the
emphasis is set to speed or accuracy. Students must choose speed or accuracy by using the
Preferences option before they select a lesson.
Speed The Paragraphs activity provides practice for increasing speed on longer copy.
(See Figure 8-6.) To establish a base keying rate, students must key as much of a
paragraph as possible in one minute. Remind your students to strike ENTER/RETURN
to complete the speed drill if they finish the paragraph before time has elapsed. If the
work is acceptably accurate, the program challenges the students to increase their speed by
two gwam for the same paragraph. When they meet the goal, the program sets a new goal
two gwam higher than the rate they just keyed. Students can continue trying to meet goals
on a paragraph as many times as they want.
The program displays the initial rate for a paragraph in orange. Then, the goal rate is
shown in yellow. If they meet the goal, the rate is shown in green; otherwise, it appears
in red.
To help your students meet intermediate speed goals, MicroType 3.0 displays a pacing
mark in the paragraph after they set the base rate. Instruct them to reach the pacing mark
before it moves. The program places the pacing marks in the copy based on the goal
divided at 15-second intervals. Depending on the goal, students may not see all four of
the pacing marks.
Accuracy With an accuracy emphasis, this lesson part provides practice for
improving control on longer copy. (See Figure 8-7.) Instruct students to key each new
paragraph at a brisk pace (not their fastest speed) while making no more than 3 uncorrected errors. When the time has elapsed or if they finish the paragraph, MicroType 3.0
displays the gwam and cwam speeds, identifies the number of errors, and highlights the
errors.
If students make three or fewer errors, the program challenges them to increase their
cwam rate by two for the same paragraph. If they reach the goal, the program will increase
the cwam goal again and asks if they want to repeat the paragraph. If they make more
than three errors, the program indicates that there are too many errors and does not
display the gwam or cwam rates. Students can repeat each paragraph an unlimited number
of times.
The program displays the initial rates and errors for a paragraph in orange. Then, the
goal rate is shown in yellow. If students meet the goal, the cwam rate is shown in green;
otherwise, it appears in red.
NOTES:
1. Students may enable or disable the BACKSPACE/DELETE key for Paragraphs with a
speed emphasis.
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Figure 8-6

Keyboarding Skill Builder (ParagraphsSpeed)

Figure 8-7

Keyboarding Skill Builder (ParagraphsAccuracy)

2. The BACKSPACE/DELETE key is always turned on regardless of the setting when
the emphasis is set to accuracy.
3. An optional count-down timer may be activated for this lesson part by using the
Preferences option.
4. During the error analysis, the program assumes a maximum of one error per incorrect
word.
5. The program assigns two additional game chances each time a student meets the next
higher goal for a paragraph.
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Measurement Writing
The Measurement Writing activity lets students practice balancing speed and control.
(See Figure 8-8.) For this activity, which is the same regardless of the emphasis, students
key two paragraphs. The program gives them two minutes to key the paragraphs with no
more than 12 uncorrected errors.

Figure 8-8

Keyboarding Skill Builder (Measurement Writing)

If there are 12 or fewer errors, MicroType 3.0 highlights the errors using the built-in
error analysis functions. It also shows the accuracy percentage (correct words ÷ total
words), number of errors, and gwam. If there are more than 12 errors, the program
indicates that there are too many errors and requires students to try again.
The software records a students results for the Measurement Writing with the highest
speed and stores the results for the most accurate writing. If a student keys the measurement writing only once, the program records the same information for both the fastest
speed and fewest errors as shown on the Lesson Report. When a Lesson Report is
printed, the text of the most recent measurement writing appears on the report along
with the other student performance data.
NOTES:
1. The BACKSPACE/DELETE key is always available for this activity.
2. Remind students to strike ENTER/RETURN after the first paragraph to display the
next paragraph. When they strike ENTER/RETURN after the last paragraph, the
programs stops the timer and computes the gwam.
3. Students may repeat the activity as many times as they want. Each time they repeat it,
they earn two extra game chances.
Game (Mystery Puzzle)
The object of the Mystery Puzzle game is to guess the answer by flipping squares on
the game board. As students flip the puzzle pieces, the program reveals a portion of the
picture. Students must use the picture and word clues to solve the puzzle (Figure 8-9).
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There are more than 45 different puzzles. The answers to the puzzles are proverbs,
titles, famous people, and events. For example, a puzzle may contain The, a map with
an arrow pointing to Kentucky, and a derby hat. The answer to this puzzle is The
Kentucky Derby.
Students earn two chances to flip a puzzle piece for most lesson parts they complete.
Also, they earn two extra chances each time they meet or exceed their speed/accuracy goal
in the Sentences and Paragraphs activities. The more times they try to improve their skill,
the more chances they earn!

Figure 8-9

Keyboarding Skill Builder (Mystery Puzzle)

When a student reveals enough of the tiles that he/she knows the answer, instruct the
student to click the Guess button and enter a guess. There are no penalties for incorrect
guesses. If a student solves the puzzle, the program displays the entire picture and then
prompts to begin another puzzle.
Hint: If students need additional chances while playing the game, instruct them to
click the Chance button to return to the lesson. Then, click on the Sentences or
Paragraphs tab and work on building skill. When they earn enough chances, they can click
on the Game tab to resume playing the game.
Inform your students not to worry if they cant solve a puzzle! The partially completed puzzle and game chances are stored with the other keying records. When your
students begin the next session, they can continue where they left off regardless of
whether they want to work in the same lesson or start a new lesson.
NOTES:
1. Game chances accumulate from session to session unless students used the Guest
button to log in to the program.
2. Some game pieces may be blank.
3. Students may accumulate up to 99 chances.
The puzzle solutions are listed here if you need assistance determining the answer to a
particular puzzle.
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Dont count your chickens
Here today, gone tomorrow
Two peas in a pod
Needle in a haystack
Monkey see, monkey do
Once in a blue moon
Penny wise, pound foolish
Raining cats and dogs
Third times a charm
Wish upon a star
Silence is golden
Calm before the storm
No time like the present
A bird in the hand
Dont rock the boat
Pale as a ghost
Home is where the heart is
A picture is worth a thousand words
Out of sight, out of mind
Keep your eye on the ball
X marks the spot
Water under the bridge
Time is money

The early bird gets the worm
Once upon a time
The Three Musketeers
A Tale of Two Cities
Treasure Island
Of Mice and Men
The Sound of Music
Gone with the Wind
The King and I
The Lion King
Wheel of Fortune
The Jungle Book
Wagon Train
Quarterback
Basketball star
Football star
Soccer match
Teddy Roosevelt
Bill Clinton
Spring break
Final exams
Grand Canyon
The Indy 500

Lesson Report
The Lesson Report shows the keying performance for the current lesson. (See Figure
8-10.) When students complete the Keyboarding Mastery or Improve Technique
activities, a check mark appears on the report. For Sentences and Paragraphs, their
average fastest speed is shown. The number of puzzles completed for the current lesson
appears on the report, too.
For the Measurement Writing activity, the software records the results for the writing
with the highest speed and stores the results for the most accurate writing, too. If
students key the Measurement Writing only once, the program records the same information for both the fastest speed and fewest errors. When students print a Lesson Report,
the text of the most recent measurement writing keyed appears on the report along with
the other information.
A BACKSPACE/DELETE icon appears next to a lesson part if a student used the
BACKSPACE/DELETE key. Students can click the Send File button to send the data
file to you for review (Windows only). To print the report, click the Print button in the
lower right corner of the notebook. The Lesson Report will appear on screen. Click the
Print button in the upper left corner to print. Click the Graph button to view the
Performance Graph. The software displays the current lesson in blue on the graph.
Diagnostic Writings
The program provides eight Diagnostic Writings that can be used for evaluating a
students skills and identifying possible areas for reteaching. You can also create additional
writings. (See page 95 for information about creating and adding writings.) Each writing
can be used for a 1', 3', or 5' timed writing.
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Figure 8-10

Keyboarding Skill Builder (Lesson Report)

Taking a Diagnostic Writing
After selecting the length of time and the diagnostic writing (Figure 8-11), the student
keys from print copy. Print the source copy by choosing Print Source Copy from the File
Menu. The students input is processed through a modified version of the Open Screen in
which the margins and tabs are preset for each document and all text is automatically left
justified. The student cannot set tabs, set margins, or center text; thus the students
efforts are focused on straight keying.
The BACKSPACE/DELETE key is available in the Diagnostic Writings if the option
has been turned on for the Keyboarding Skill Builder section.
When time has elapsed, the program highlights the errors and displays the students speed
and number of errors. A student who completes the diagnostic writing before the time has
elapsed should key the writing again. Students should strike ENTER/RETURN at the end of
the last sentence. To end a diagnostic writing before time expires, strike the ESC key or click
the timer in the bottom right corner of the screen.
Practicing Error Words
Students are given the option to practice selected error words. Since errors may be
triggered by reaches in adjacent words, they practice error words in context. For each
error word, students key the word that precedes it, the error word itself, and the word
that follows it.
Not every error word is presented for practice. Sometimes a single lapse in concentration can result in a string of error words. In cases where there are several error words in a
row, all words in the group may be omitted from practice. Generally, the error words
practiced are single, isolated words or small groups.
Reviewing the Error Analysis
The program highlights errors, computes the speed, and displays number of errors. On
the second attempt, however, the program provides a more detailed analysis of the errors
in the students copy. The program categorizes errors as being one of the following:
missing word, extra word, transposed words, missing character, extra character, trans56
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Figure 8-11

Keyboarding Skill Builder

(Diagnostic Writing Selection)

posed characters, spacing, single character, capitalization, punctuation, missing carriage
return, extra carriage return, or other.
The program uses the spaces in the students text to divide it into words. Each error
word falls into exactly one category. The categories of missing word, extra word,
transposed words, missing carriage return, and extra carriage return are self-explanatory.
A list of criteria used for the other categories follows:
missing character
the word is correct except for one missing character
extra character
the word is correct except for one extra character
transposed characters the word is correct except for two adjacent characters that
are transposed
single character
the word is correct except for a single incorrect character
spacing
the word is correct, but contains an internal space; or the
student keyed too many or too few spaces after the word
capitalization
the word has the correct characters, but one or more letters
are in the wrong case (are capitalized but should be lower
case or are lower case but should be capitalized)
punctuation
the word is correct except for one missing punctuation
mark or one incorrect punctuation mark
Any error word that does not fit one of the categories above is classified as other.
Words that contain more than one error are usually categorized as other.
Since punctuation and capitalization errors are often special cases of other errors, the
program checks for these two types of errors first.
NOTE: No error analysis algorithm is 100 percent accurate all the time. The
programs algorithm is very accurate, but it may on occasion give an incorrect error count
or put an error in the wrong category. Such an occurrence is most likely to happen when
there are two or more errors in a row.
In addition to sorting the errors into these categories, the program also keeps records
that can help select appropriate reteaching activities or drill materials. An analysis report
is attached to each diagnostic writing. Whenever a single-character error occurs, the
program tallies the number of times that character has been keyed incorrectly. For
example, if the student keys tje for the, the program adds 1 to its tally for the letter
h. The letter-by-letter tally is displayed as part of each diagnostic writing.
The program also keeps tallies for pairs of letters that are frequently interchanged or
transposed. Whenever a students error fits one of these categories, the tallies are
Section 8

Keyboarding Skill Builder

57

updated. The program keeps records of the following:
Interchanged pairs: t/r, m/n, o/i, a/s, e/i, s/d, r/e, v/b, e/d, o/l, g/f
Transposed pairs: a/s, e/r, o/p, i/o, o/l
Use the data for specific single characters, interchanged pairs, and transposed pairs for
analysis rather than for counting errors, because one single-character error can cause
several tallies to be updated. For example, if a student keys thim for them, the error
would be categorized as a single-character error; however the tallies for the letter e and
the e/i interchange would be updated as well.
Saving a Diagnostic Writing
After reviewing the error information for a second attempt, a student can save the
diagnostic writing and the analysis report. The program also automatically saves the
diagnostic writing summary information (date, timed writing length, gwam, errors, and
BACKSPACE/DELETE usage) in the students performance data record. Print a
Summary Report to access this information.
In most cases, students will use the full time allotted; but a student who keys rapidly
could finish a diagnostic writing before the time has elapsed and strike ESC to end. A
student could also key for a very short time and choose to stop the timer, thereby
recording an unrealistic gwam and number of errors. Having access to the actual time
spent keying helps you identify these special cases.
If a student has 5 or fewer errors per minute, the program automatically updates all
the cumulative error tallies. If a student has more than 5 errors per minute, the program
gives the student the option of adding the errors to the cumulative record. This option is
provided to reduce the chance of recording skewed error information resulting from a
student skipping a line or paragraph of the copy.
The program keeps cumulative error tallies for an unlimited number of diagnostic
writings, but it saves summary data (name, time, gwam, etc.) for a maximum of 50
diagnostic writings. If the student keys more than 50 diagnostic writings, information for
the oldest diagnostic writings is erased.
To save an actual diagnostic writing document, instruct your students to select the Save
option from the File menu. Students must enter a file name and can choose where to save the
file. If students do not designate a path, the files will be saved to the directory students
designated for their records the first time they used the program.
MicroType 3.0 saves both the text keyed with the error symbols and the analysis. Even
if a student does not save the diagnostic writing, the summary performance results are
accumulated in his/her personal record.
Printing a Diagnostic Writing
Immediately after taking a diagnostic writing, students can print the writing and the
analysis by choosing the Print option from the File menu. Later, a student may open a
saved diagnostic writing, review his/her errors, and print the document. After a student
finishes a diagnostic writing, the document cannot be edited. A sample report is shown in
Figure 8-12.
Opening and Printing a Saved Diagnostic Writing
To open a diagnostic writing, click the Diagnostic Writing button on the Numeric
Keyboarding or Keyboarding Skill Builder Lesson menu. When the Diagnostic Writing
dialog box appears, click the Cancel button. Then, pull down the File menu and choose
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Open Diagnostic Writing to open any saved diagnostic writing. After opening a file, students
can only view the document or print it. The MicroType 3.0 program does not allow
students to edit a completed diagnostic writing.
Preferences
By setting Preferences, you, the teacher, can control the following aspects of the Skill
Builder section. Only those items marked with an asterisk (*) can be changed by students.
Also, the other teacher-controlled options do not appear in the Preferences dialog box
that your students can access. However, you may change any of these items by using the
teacher utilities. Refer to the instructions beginning on page 89.
Students may access their personal keyboarding options by choosing the Preferences
option from the Edit menu. The Preferences are categorized by section. To change an
option, instruct your students to simply click the corresponding option. If a category is
locked, students may not change any of the options for that section.
NOTE: When students access the Diagnostic Writings from the Skill Builder Lesson
menu, the status of the BACKSPACE/DELETE key is determined by the setting for this
section.
General Preferences

Skill Builder Preferences

 Show lesson movies*

 Accuracy rate (50%)

 Play movie audio *

 Backspace allowed*

 Play narration/effects Audio *

 Show Time Remaining*

 Use Bookmark *

 Timer Sound *

 Allow game access

 Emphasis (Speed or Accuracy)*

 Allow students to change password
 Two spaces after end punctuation*
 Create sub-folder for each student
 Language (English/Spanish)*
 Teacher Email Address*
Teaching Suggestions
Keyboarding Skill Builder offers a wide range of options for practice and evaluation,
which allows you to customize the program for each student. You can choose to have a
student use the speed format or the accuracy format for the lessons, depending on
whether speed or accuracy represents the students weakness. For most students, you
will find it appropriate to alternate between the two modes from day to day or week to
week.
Use data from the Lesson Report and Summary Report for formative evaluation and
to see general progress and trends. The Diagnostic Writings features can be used periodically for formative and/or summative evaluation.
Review the error analysis for an individual diagnostic writing or the cumulative
analysis to pinpoint areas where a student needs remediation and prescribe copy designed
for that purpose.
Print the Diagnostic Writings part of the Summary Report for each student on a
regular basis and keep it in a folder. Then, if you prescribe remediation for the student
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Diagnostic Writing
Writing: Writing 1
Time: 1 minute
First Attempt (1.00 min)
Speed: 39 gwam
Errors: 12
BACKSPACE key used 8 times
Error words practiced? Yes

Second Attempt (1.00 min.)
Speed: 44 gwam
Errors: 10
BACKSPACE key used 4 times

Analysis of Errors (second attempt only)
Missing Word (or Tab):
0
Extra Word (or Tab):
0
Transposed Words:
0
Missing Character:
1
Extra Character:
1
Transposed Characters:
2
Single Character:
2

Extra Carriage Return:
Missing Carriage Return:
Spacing:
Capitalization:
Punctuation:
Other:

Errors by Character (character and number of errors)
a -0
b -0
c -0
d -1
e -0
h -0
i -0
j -0
k -0
l -0
o -0
p -1
q -0
r -0
s -0
v -0
w -0
x -0
y -0
z -0

1
2
0
0
0
1

f -0
m-0
t -0

g -0
n -0
u -0

0 -0
7 -0

1 -0
8 -0

2 -0
9 -0

3 -0

4 -0

5 -0

6 -0

. -0
%- 0
“ -0

, -0
- -0
* -0

; -0
# -0
_ -0

? -0
& -0

: -0
( -0

/ -0
) -0

$ -0
‘ -0

Commonly Interchanged Pairs (pair and number of errors)
t/r - 0
m/n - 0
o/i - 0
a/s - 0
r/e - 0
v/b - 0
e/d - 0
o/l - 0

e/i - 1
g/f - 0

Commonly Transposed Pairs (pair and number of errors)
a/s - 0
e/r - 0
o/p - 0
i/o - 0

o/l - 0

Figure 8-12
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s/d - 0

(Diagnostic Writing Report)

based on the report, you can determine if the remediation has been successful. For
example, if a students cumulative error analysis shows a disproportionate number of
spacing errors, you may want to observe that students spacing technique and assign
spacing drills. After remediation, check the cumulative error analysis to determine if the
student is making fewer spacing errors.
Use all three lengths of timings on the diagnostic writings. The 1' writings provide good
speed data; the 5' writings indicate endurance and are best for obtaining a representative
sampling of persistent errors. The 3' writings are effective for measuring speed and accuracy
and are good diagnostic tools in early skill-building stages.
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SECTION 9

NUMERIC KEYPAD

The Numeric Keypad section includes four instructional lessons designed to help
students learn the keypad: 0 - 9, period ( . ), and ENTER/RETURN. Access to the
Keypad Timed Writings and Keypad Practice options is available in the Numeric Keypad
section, too.
Each lesson requires approximately 20 to 25 minutes. On average, one lesson should
be completed each practice session. Keys learned in early lessons are reused systematically
in later lessons. Therefore, instruct students to complete the lessons in the appropriate
sequence.
NumLock must be on for students to use the numeric keypad (Windows only).
Key Presentation
The lessons and the keys taught are listed as follows:
Lesson 1:
4, 5, 6, 0, ENTER/RETURN
Lesson 2:
7, 8, 9
Lesson 3:
1, 2, 3
Lesson 4:
(.)
Navigating Numeric Keypad
All of the lessons in the Numeric Keypad section utilize the same navigation techniques. Except for two new buttons, students will find that this section is very similar to
the other keyboarding sections. (See Figure 9-1.)

Keypad Practice
Timed Writings
Back

Figure 9-1

Numeric Keypad Lesson Menu

The students can click the Home button in the upper left corner of the screen to
return to the Main menu. The Help and Open Screen buttons appear below the Home
button.
To select a lesson from the Numeric Keypad Lesson menu, click the name of the
desired lesson.
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Any time you want your students to practice their keyboarding skills, instruct them to
simply press the Keypad Practice button to access the simulated calculator. The
program sums the figures students enter so that they can check their work for accuracy.
Clicking the Timed Writings button presents data sets that emphasize and evaluate
specific reaches.
The Back button appears on the Lesson menu and in every other lesson part including
the game. Students can use this button to return to the previous menu. Clicking the
Back button here goes back to the Main menu.
Lesson Design
Most lessons provide a warm-up and review (Conditioning Practice), introduce one or
more new keys (Learn Key), provide practice on specific reaches and techniques (Improve
Keystroking), help students develop fluency (Build Skill), and include a skill-building
game (Worldwide Shipping, Inc.). In Lesson 1, a Learn Home Row activity is used
instead of Learn Key. Also, Lesson 1 does not include a Conditioning Practice activity.
After a student selects a lesson, the program displays a notebook with the first learning
activity. The highlighted (yellow) tab at the bottom of the notebook indicates the current
lesson activity. Each lesson part is labeled. If a student partially completes a lesson, he/
she should select the appropriate lesson and then click the corresponding notebook tab to
continue working with the tutorial.
Conditioning Practice
The Conditioning Practice activity provides the opportunity for students to practice
their numeric keypad skills prior to learning a new key. (See Figure 9-2.) For each drill set,
instruct your students to key the column of numbers once for practice and a second time
for speed. The program shows their speed in keystrokes per minute (kspm) after the
second attempt. Students must key the drill lines at an acceptable accuracy rate;
otherwise, the program indicates that there are too many errors.

Figure 9-2
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Technique hints and photos provide tips that help your students focus on improving
their keyboarding skill. Remind students to review these technique hints as they work
through this activity.
Depending on the keyboarding Preferences, the program may or may not allow
students to use the BACKSPACE/DELETE key in this lesson part. Students cannot use
the BACKSPACE/DELETE key if the BACKSPACE/DELETE icon with the red circle
appears in the lower left corner of the notebook.
Learn Key
The Learn Key lesson part identifies the location of the new key, shows which finger
to use, demonstrates the proper key reach, and lets students practice the new key reach.
(See Figure 9-3.) Drill lines are presented using the lock-and-flash practice technique.
NOTE: The BACKSPACE/DELETE key is always disabled in this lesson part and
does not appear on the notebook regardless of the Preferences setting.
Movies The Lesson 1 Learn New Keys tab contains a movie illustrating correct
finger placement on the Numeric Keypad. Use the Rewind, Pause, and Fast Forward keys
to control the movie. Strike Enter to end the movie. This movie is also available from the
Main menu by clicking on the Movies button. Teachers and students can disable the lesson
movies using the Preferences option.
3-D Viewer Following the keypad movie, a 3-D viewer is presented. Using the 3-D
viewer, students can rotate the model to view proper finger position on the keypad. Use
the cursor hand or the cursor keys to rotate the model. Strike Enter to close the 3-D
viewer. The 3-D viewer is also available from the Main menu by clicking on the 3-D
button. Teachers and students can disable the lesson 3-D viewer using the Preferences
option.

Figure 9-3

Numeric Keypad (Learn Key)
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Improve Keystroking
The Improve Keystroking activity provides practice on specific reaches and techniques.
The MicroType 3.0 software presents a column of numbers for students to key using the
word-lock approach. The number of drills in this part varies from lesson to lesson. (See
Figure 9-4.)
Technique hints and photos provide tips that help students improve their numeric
keypad skill. The emphasis for the drill also appears as a reference.
NOTE: The BACKSPACE/DELETE key is always disabled in this lesson part and
does not appear on the notebook regardless of the Preferences setting.

Figure 9-4

Numeric Keypad (Improve Keystroking)

Build Skill
The Build Skill activity presents drills for students to key using the column-check
practice mode. Students enter the column of figures once to establish a speed goal. (See
Figure 9-5.) If they meet the accuracy requirement, the program shows the actual kspm
rate in orange and then makes it the goal speed when ENTER/RETURN is pressed.
The MicroType 3.0 program challenges your students to meet their goal rate twice. If
they meet or exceed the goal, the rate appears in green; otherwise, the program displays
the kspm in red. If a student keys too many errors, the program does not display the
speed.
For the Build Skill lesson part, the program records the following information:
Average speed Drills must meet or exceed the accuracy requirement to be included
in the average-speed calculation.
Fastest speed

The fastest speed is based on all of the drill sets in this lesson part.

Drill sets

The program stores the last attempt for each drill set. If students
choose to print the Lesson Report, the original copy and the actual
drill copy keyed appear on the report.
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Figure 9-5

Numeric Keypad (Build Skill)

NOTES:
1. The timer does not start until students key the first digit.
2. If the BACKSPACE/DELETE key is disabled, an icon with a red circle appears in the
lower left corner of the notebook.
3. MicroType 3.0 stores only the most recent keying information if your students complete
a lesson part more than once.
Game (Worldwide Shipping, Inc.)
As employees of Worldwide Shipping, Inc., students process the packages shipped by
the company. Instruct them to key the figures that appear on the console to process the
shipping information. (See Figure 9-6.)
Beginning a New Game The kspm goal for a game is 90% of the average speed
that a student attains in the Build Skill activity or it is determined by a teacher option if
the student did not complete the Build Skill part. The number of drills that are presented
in each game is a teacher option, too.
The score area at the bottom of the input console shows the score, the actual kspm
rate, and the kspm goal.
As a student plays the game, the packages move on the conveyor belt after striking the
first digit if the mode is set to real-time. Otherwise, the action occurs after keying the
last figure. Instruct your students to always key each drill set as quickly and accurately as
possible. Remind them to strike ENTER/RETURN after each figure. If students make
too many errors in a drill set, the kspm rate will not be included in the final results.
NOTE: The BACKSPACE/DELETE setting (on or off) used in the lesson also
applies to the game. A student must set the Preferences before beginning a new game.
Delayed vs. Real-Time Mode Students can play the game in delayed mode or in
real-time mode. In delayed mode, the action occurs after a student keys the entire drill set
and strikes ENTER/RETURN. Then, the packages with the figures from the drill set
begin to move across the screen. If a figure was successfully keyed at or above the kspm
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Figure 9-6

Numeric Keypad (Worldwide Shipping, Inc.)

goal, an OK stamp (correct) appears on the box; otherwise, an X stamp (incorrect)
appears on the package.
Playing the game in real-time mode can be more challenging because it forces students
to focus on the figures in the drill set. As soon as students start keying the first figure, the
packages start moving across the screen on a conveyor belt. The program checks the
accuracy and rate when students strike ENTER/RETURN after each figure to determine
if it should stamp an OK or X on the package.
Earning Points Students earn 100 points for each figure keyed correctly within the
kspm goal rate. The program awards an additional 1000 bonus points if the entire drill set
is keyed correctly at (or above) the kspm goal.
MicroType 3.0 keeps a list of the top ten scores for the Worldwide Shipping game.
Select the Top Ten Lists option in the Reports menu to display the list.
Game Over The game ends after a student keys all of the drill sets. The program
displays the total score, fastest speed, average speed, and goal speed. This information
also appears on the Lesson Report. If a student plays the game more than once in a single
lesson, MicroType 3.0 stores only the most recent score.
Playing the Game Outside of the Lessons The Worldwide Shipping game is
available outside of the lessons by clicking on the Games button from the Main menu.
The figures presented in the Worldwide Shipping game outside of the lessons contain all
of the keypad numbers; therefore, students should not begin using the Worldwide
Shipping game outside of the lessons until they have completed the Numeric Keypad
module.
The kspm goal is approximately 90% of the average speed that a student attained in all
of the Build Skill parts completed in the Numeric Keypad lessons. If a student did not
complete a Build Skill part, the program uses the Numeric Keypad goal specified in the
Preferences.
Lesson Report
The Lesson Report shows the performance for each lesson. (See Figure 9-7.) When a
student completes the Conditioning Practice, Learn Key, or Improve Keystroking activity,
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Figure 9-7

Numeric Keypad (Lesson Report)

a check mark appears next to that item on the report. In addition, the Lesson Report
includes the average and fastest speeds for both the Build Skill part and the Worldwide
Shipping game. The drill sets keyed in the Build Skill part appear on the report if it is
printed. The goal speed and total score for the game appear on the report, too.
A BACKSPACE/DELETE icon appears next to a lesson part if a student used the
BACKSPACE/DELETE key. Students can click the Send File button to send the data
file to you for review. To print the report, click the Print button in the lower right
corner of the notebook. The Lesson Report will appear on screen. Click the Print
button in the upper left corner to print. Click the Graph button to view the Performance
Graph. The software displays the current lesson in blue.
Keypad Practice
While learning the numeric keypad, students can better their skills by using the Keypad
Practice option. (See Figure 9-8.) This feature accepts numeric input and then sums the
figures so that your students can check their accuracy. To access the Keypad Practice
option, click the button that appears on the Numeric Keypad Lesson menu. Students can
use their textbook or any other source for practice material. Up to a hundred figures may
be entered per set.
To practice using the keypad:
1. Click the Keypad Practice button on the Numeric Keypad Lesson menu.
2. Begin keying (e.g., .0146, 12.35, 1375, etc.) and strike ENTER/RETURN after each
figure.
3. Strike ENTER/RETURN twice to sum the amounts keyed.
4. Check the total shown at the bottom of the practice area to verify the accuracy of the
input.
5. After finishing a set, students can review their work, click the Print button to print
the figures, or begin a new practice session.
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Figure 9-8

Keypad Practice

NOTE: The BACKSPACE/DELETE key can be enabled/disabled for the Keypad
Practice, but students must set the BACKSPACE/DELETE key before they access the
practice option. The Numeric Keypad Preferences setting controls the BACKSPACE/
DELETE key in the Keypad Practice option.
Timed Writings
The Timed Writings option, which is available from the Numeric Keypad Lesson
menu, provides additional numeric keypad practice. When students access this option,
they select from any of the following timed writings. Also, you may prepare up to five
supplemental timed writings. (See Create Keypad Timed Writings on page 95.)
The emphasis for each group is presented in the following list.
Group
1
2
3
4
5
6
7
8
9

Emphasis
Home row
Top row
Bottom row
All rows, no decimals
All rows, with decimals
Mixed lengths, no decimals
Mixed lengths, with decimals
Long random numbers, no decimals
Long random numbers, with decimals

After students key each writing, MicroType 3.0 shows their kspm and errors. (See Figure
9-9.) Group statistics including fastest rate, average kspm, and error rate appear to the
right of the keying area. When students finish a group, the program asks to repeat this
exercise. At this time, students can click the Print button to print the timed writings
keyed along with the performance results (fastest speed, average kspm, and error rate).
MicroType 3.0 automatically stores the performance results after each timed writing. If
students complete the same timed writing several times, the program saves only the latest
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information. Choose the Keypad Timed Writings option in the Reports menu to access this
data at a later time. The report includes both the group statistics and the actual timed
writings keyed.

Figure 9-9

Keypad Timed Writings

NOTE: The BACKSPACE/DELETE key can be enabled/disabled for the Keypad
Timed Writings option, but students must change the status before they access the analysis
option. The Numeric Keypad Preferences setting controls the BACKSPACE/DELETE
key in the Keypad Timed Writings option.
Preferences
By setting Preferences, you can control the following aspects of the Numeric Keypad
section. Only those items marked with an asterisk (*) can be changed by students. The
teacher-controlled options do not appear in the Preferences dialog box that your
students can access. However, you may change any of these items by using the teacher
utilities. Refer to the instructions beginning on page 89.
General Preferences

Numeric Keypad Preferences

 Show lesson movies*

 Accuracy rate (50%)

 Play movie audio *

 Backspace allowed*

 Play narration/effects Audio *

 Game Goal (75 kspm)

 Use Bookmark *

 Game Drill Sets (6)

 Allow game access

 Game Delayed Action*

 Allow students to change password
 Two spaces after end punctuation*
 Create sub-folder for each student
 Language (English/Spanish)*
 Teacher Email Address*
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Students may access their personal keyboarding options by choosing the Preferences
option from the Edit menu. As illustrated in Figure 9-10, the Preferences are categorized
by section. To change an option, instruct your students to simply click the corresponding
option. If a category is locked, students may not change any of the options for that
section.
Teaching Suggestions
The Numeric Keypad section provides a thorough introduction to the keypad. By
using the Keypad Practice, Keypad Timed Writings, and Worldwide Shipping game you
can extend the duration of the keypad instruction.
Instruct students to make a conscientious decision about when to use the top-row
numbers and when to use the numeric keypad. In general, the keypad should be used for
blocks of numeric input. The top-row figures should be used for mixed (alphanumeric)
copy.
Left-handed students should be encouraged to use their right hands when operating
the numeric keypad. The design of the keypad and its placement on most keyboards make
it very difficult to use the left hand. If a student cannot operate the keypad at all with
his/her right hand, you will have to remind the student to reverse all finger assignments.
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SECTION 10 OPEN SCREEN (WORD PROCESSOR)
At almost any time while your students use the MicroType 3.0 software, they can access
the Open Screen (word processor) feature by simply clicking a button. The word
processor is a comprehensive application that students can use to practice their keyboarding skill, create a letter, or take a timed writing.
The word processor includes the following features:






Fonts, styles, sizes
Toolbar
Built-in timer
Spell checker
Margins







Paragraph formatting
Tabs
Adjustable line spacing
Page numbers
Headers and footers

Navigating the Open Screen (Word Processor)
The word processor option in the MicroType 3.0 software is a full-featured application
that includes features such as styles, tabs, fonts, spell checker, cut, copy, paste, and many
others. The toolbar, shown in Figure 10-1, and the ruler provide a shortcut to access
many of these features.

Figure 10-1

Word Processor Toolbar

The ruler, illustrated in Figure 10-2, includes controls that allow students to set and
delete tabs, change line spacing, and adjust the margins. For example, select decimal tab
style and then click on the ruler to set a decimal tab at that position. Tabs and the other
controls are identified on the ruler shown in Figure 10-2.

Figure 10-2

Word Processor Ruler

Choose the Exit Open Screen option in the File menu to close a document and return
to the tutorial.
Creating a New Document
Follow the instructions provided to create a new document. Only one document may
be open at a time. If another document is already open, the program will prompt to save
the document if you havent already done so.
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To create a new document:
1. Save the current document.
2. Pull down the File menu and choose New, or click the New icon on the toolbar. [See
Navigating the Open Screen (Word Processor).]
3. Begin keying the document.
Opening/Saving a Document
Follow the instructions provided to open and save documents while using the word
processor. Only one document may be open at a time.
To open a document:
1. Save the current document.
2. Pull down the File menu and choose Open, or click the Open icon on the toolbar.
3. Continue working with the document.
To save a document, select the Save option in the File menu to save a document using
the current file name. Choose the Save As option to assign a different file name. As a
shortcut, click the Save (disk) icon on the toolbar to save a document.
NOTES:
1. If a student opens a completed timed writing, the program does not let the student
edit the document.
2. Using the Save As option you can set the file type to RTF (rich text format) to save a
document for use with another word processor.
Printing a Document
Follow the instructions provided to print a document.
1. Save the current document.
2. (Optional) Windows: Select the Printer Setup option in the File menu to select a printer.
Macintosh: Use the Page Setup command in the File menu to get the page options.
3. Pull down the File menu and choose Print, or click the Print icon on the toolbar.
Formatting Documents
MicroType 3.0 offers numerous formatting options that your students can use while
working with the word processor. Some of these options are presented here, however,
detailed step-by-step instructions are provided in the help for all of the many word
processor features including:
 Styles

 Headers/footers

 Fonts

 Tables

 Tabs

 Columns

 Justification

 Page numbers

 Line spacing

 Center title page

 Margins

 Hard page break

To use styles and fonts in a document (Figure 10-3):
 Select a block of text and choose the desired style(s) and/or font. The more
commonly used styles appear on the toolbar and are assigned hot keys.
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 Select a font, choose one or more styles (bold, italic, underline, color, font size, etc.),
and begin keying. The text appears in the selected font/style as you key. Choose the
Regular [CTRL+T (Windows) or CMD+T (Macintosh)] option to set the style to
normal.
 Use the Font option in the Format menu to set multiple styles, select a font, and
specify a font size at one time.
 Click on a word that contains the desired style, choose the Copy Style option from the
Format menu, select the text to change, and choose the Apply Style option to set the
new style. This option applies the copied font, font size, and style(s).
Figure 10-3
B ox

Font Dialog

Setting tabs in a document:
 Choose the Show Ruler and/or Show Toolbar option in the View menu if the ruler or
toolbar does not appear on the screen. You can use the ruler or the Tabs option in
the Format menu to set, change, and delete tabs.
 As with any ruler setting, the changes students make apply to the current paragraph
(the paragraph that contains the flashing insertion point). If multiple paragraphs are
selected, the changes apply to the selected paragraphs. A paragraph is defined as a
block of text that ends with a carriage return. You can view these codes by using
the Show Codes command in the View menu.
 To set a new tab stop, click on the Tab Type toolbar button to set the tab type (left,
center, decimal, or right) shown at the lower left side of the ruler. Then, click on
the ruler to position the new tab at that location.
 To move a tab, click on the corresponding tab shown on the ruler and drag it to its
new location.
 To remove a tab, click on it and drag it off the bottom of the ruler.
To set justification, indents, and margins in a document:
 Choose the Show Ruler and/or Show Toolbar option in the View menu if the ruler or
toolbar does not appear on the screen. You can set justification, indents, and margins
by using the ruler or with the corresponding options in the Format menu.
 As with other ruler settings, changes to justification, indents, and margins apply to
the selected paragraph(s).
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 To set the justification, click the desired paragraph justification icon (left, centered,
or right).
 To indent a paragraph, drag either the top or bottom part of the left margin indicator
to the desired position.
 To change the left margin, drag both the top and bottom parts of left margin to the
new margin setting. Move the right margin indicator to set the right margin.
 To set the top and bottom margins, use the Page Settings option in the Format menu.
This is a page setting rather than a ruler setting. Setting the top/bottom margins
applies this change to all pages in a document unless there is a page break.
Figure 10-4
Dialog Box

Page Settings

To add a header or footer to a document (Figure 10-5):
 Select either the Headers or Footers option from the Format menu. Enter the text to
appear in the header/footer, set the placement, and click the Record button.
 Each document may contain two separate headers and footers, but only one of each
may appear on a page. Once set, a header/footer appears on all pages except as
noted by the placement. Students can specify that the header/footer appears on all
pages, even numbered pages, or odd numbered pages. Headers and footers can be set
to not appear on a title page by using the Page Settings option.
 To remove a header/footer, select the appropriate option and delete the text that
appears in the window.
To insert a page number in a document:
 Select the Page Number option in the Insert menu to insert a page number.
If you want the page number to appear on every page, it is best to create a header or
footer and insert the page number accordingly.
 If you want to suppress page numbers on selected pages (e.g., a title page), insert a
section break. Choose the Page Settings option and turn off the page number on that
page.
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Figure 10-5

Headers Window

To insert/delete a break (Figure 10-6):
 Choose the Break option from the Insert menu.
Use the insert break command to insert a page, section, column, or text wrapping
break. Page breaks let you begin a new page without filling the page with carriage
returns. Section breaks are useful if you want to apply unique page settings across a
document. For example, you could create a title page with the page settings to center
the page and suppress page numbers. Then, you would insert a section break and set
the page justification to top and turn on page numbers.
 As a shortcut, you can insert a page break at the insertion point, by pressing
CTRL+ENTER (Windows) or OPTION+RETURN (Macintosh).
 To delete a hard page break, position the insertion point immediately after the page
break and press the BACKSPACE/DELETE key.
 Use the Show Codes option to view page, section, column, and text wrapping breaks.
Figure 10-6
Window

Insert Break

To vertically center the first page (e.g., title page) in a document (Figure 10-7):
 Key the text or title page information on the first page.
 Choose Break from the Insert menu and choose to insert a section break.
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 Position the cursor on the first page.
 Choose the Page Settings option in the Format menu. Set the vertical alignment to
center and turn off headers and footers.
Figure 10-7
B ox

Page Settings Dialog

Finding/Replacing Text
Working with a document, students can find and/or replace text in a document. (See
Figure 10-8.) To find text in a document:
1. Select the Find option from the Edit menu.
2. Enter the text that you want to find.
3. (Optional) Set the Match case, From cursor, and Find whole words only options.
4. Click the Find button until the program locates the text in the document.
5. Click the Cancel button to close the Find dialog box and return to the document.
Figure 10-8

Find Dialog Box

To replace text in a document:
1. Select the Replace option from the Edit menu.
2. Enter the text that you want to find and the replacement text.
3. (Optional) Set the find/replace options.
4. Click the Replace button to replace the first occurrence of the text in the document.
Click the Replace button again to replace the next occurrence.
5. Click the Replace All button to replace all occurrences of the text. Be careful using
this option especially if the Prompt to Replace option is disabled.
6. Click the Cancel button to close the Replace dialog box and return to the document.
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Taking a Timed Writing
Using the word processor, your students can take either a count-down or count-up
timed writing using any drill copy. (See Figure 10-9.) Use the count-down timer option
for regular speed timed writings. Students specify the timed writing length from 15
seconds to 5 minutes. A variable length timed writing option is also available. The timer
counts down from the specified time until it reaches zero. While taking a timed writing,
only a few of the word processor commands are enabled. For example, students cannot
change the ruler settings and copy/paste text.
For production work, instruct your students to use the count-up timer option. The
timer starts at zero and counts up until the student finishes his/her work on a document. All of the word processor commands are available using this timed writing mode
except if the Paste command is disabled. If a student cannot finish a count-up timed
writing during a session, instruct the student to save the document; dont stop the timer.
When the student opens the document at the beginning of the next session, the timer
begins at the appropriate time setting. The timed writing results include the elapsed time,
words keyed, gwam, and edit passes. The edit passes information is incremented each time
a student saves and then opens a document during a count-up timed writing.
Figure 10-9 Count-up/
Count-down Timer Options

After finishing a count-up or count-down timed writing, the program appends the
timed writing results to the document. MicroType 3.0 will not allow a student to edit a
timed writing once completed. This feature is included so that students do not take a
timed writing and then alter the actual timing or the results.
Count-Down Timer
Use the count-down timer for regular speed drills. As its name implies, the
count-down timer, begins at the time set and counts down to zero.
To take a count-down timed writing:
1. Save the current document, if necessary.
2. Pull down the Edit menu and choose Timer, or click the Timer icon in the lower, right
corner of the window.
3. When the Timer dialog box appears, specify a count-down timer and indicate the
timed writing length.
4. Set the timer options.
5. Click the OK button to begin the timed writing.
Section 10 Open Screen (Word Processor)
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6. Begin keying. Key until the timer reaches zero.
The timer does not start counting down until a student strikes the first key. If the
BACKSPACE/DELETE key was turned off in the preferences, it will be turned off
during the timed writing.
7. Review the timed writing results and then click the OK button to close the dialog box.
These results are appended to the end of the document, too. After a student completes a count-down timed writing, the document cannot be edited. Scrolling through the
document, saving, and printing are the only valid options.
NOTES:
1. MicroType 3.0 starts each timed writing with a blank document.
2. Many of the editing commands are not available during a count-down timed writing.
3. To stop a timed writing, choose the Timer option or click the Timer (stop watch) icon.
Count-Up Timer
Use the count-up timer for production work such as letters or reports. The count-up
timer begins at zero and counts up to a maximum of 99 minutes and 59 seconds.
To take a count-up timed writing:
1. Save the current document, if necessary.
2. Pull down the Edit menu and choose Timer, or click the Timer (stop watch) icon.
3. When the Timer dialog box appears, specify a count-up timer.
4. Set the timer options.
5. Click the OK button to begin the timed writing.
6. Begin keying.
The timer starts immediately after a student clicks the OK button to begin the timed
writing. If a student is interrupted, he/she can save the document and open it later.
When a student opens a count-up timed writing document that is currently in progress,
the timer begins where he/she left off.
7. Stop the timer only when you completely finish a timed writing. Choose Timer from
the Edit menu or click the Timer (stop watch) icon.
8. Review the timed writing results and click the OK button to close the dialog box.
These results are appended to the end of the document, too.
NOTES:
1. Most of the editing functions, except the Paste if it was turned off, are available
during the count-up timed writing. This prevents students from inflating their gwam
by pasting text from another source into the document.
2. After a student stops the timed writing, the document cannot be edited. Scrolling
through the document, saving, and printing are the only valid options.
3. Since the count-up timer is used for production work, the program does not show the
timing results in a footer on each page. Rather, the results are appended to the
document using a separate page.
4. If your students share a printer, instruct them to include a header or footer with their
name to help identify the documents.
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SECTION 11 STUDENT REPORTS
The MicroType 3.0 software provides numerous reports that students can generate.
These reports include: Lesson Report, Summary Report, Keypad Timed Writings, Top Ten
Lists, Certificate of Completion, and Performance Graphs. All of these reports, except
the Lesson Report, are accessed by using the Reports menu.
Lesson Report
Every lesson in each of the four keyboarding sections includes a Lesson Report. (See
Figure 11-1.) This report shows a students performance data for the corresponding
lesson. The Lesson Report includes the most recent source copy and the students actual
copy for either the Build Skill or Measurement Writing exercises.
To display/print a Lesson Report:
1. Select the appropriate keyboarding section (Alphabetic Keyboarding, Numeric
Keyboarding, Keyboarding Skill Builder, or Numeric Keypad) from the Main menu if
necessary.
2. Choose a lesson.
3. Click the Lesson Report tab at the bottom of the notebook to display the report for
the lesson.
4. Click the Print button to print the report. The Lesson Report will appear on screen.
Click the Print button in the upper left corner to print.
NOTE: For the Skill Builder section, there are actually two sets of Lesson Reports
speed and accuracy. The Lesson Report will show only the performance data for the
current emphasis. The Summary Report shows both sets of data.
Summary Report
The information included on the Summary Report reflects a students results for the
entire MicroType 3.0 keyboarding tutorial. A partial Summary Report is presented in
Figure 11-2 on page 81. The complete report includes performance data for the following
areas:
 Skill Analysis Timed Writing
 Alphabetic Keyboarding
 Numeric Keyboarding
 Keyboarding Skill Builder
 Numeric Keypad
 Diagnostic Writings
NOTES:
1. Summary data is not stored if a student logs in as a guest.
2. The Summary Report may require up to nine pages to print an entire report. However, the program will skip those sections that do not include any performance data.
3. Only the 50 most recent diagnostic writings appear on the Summary Report, but the
cumulative analysis reflects the results for all writings.
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Student Name
Class ID: 101
Nov. 25, 20—
MicroType: Alphabetic Keyboarding
Lesson 3 — Learn h and e (Completed: 11/25/—)
Section
Conditioning Practice † .........................
Learn h .................................................
Learn e .................................................
Combine h and e ..................................
Improve Keystroking ............................
Build Skill †
Average Speed ..............................
Fastest Speed ................................
Game †
Average Speed ..............................
Fastest Speed ................................
Goal Speed .....................................
Score ..............................................
†

ü
ü
ü
ü
ü
34 gwam
38 gwam
35 gwam
39 gwam
30 gwam
166 points

Backspace key used in lesson section

Build Skill:
Original / Student’s
hj hj ah ah ha ha had had ash ash has has had hash
hj hj ah ah ha ha had had ash ash has has had hash
ed ed el el ed ed led led eke eke lee lee ale kale
ed ed el el ed ed led led eke eke lee lee ale kals
he he she she led led has has held held sled sleds
he he she she led led has has held held sled sleds
he fled; she led; she had jade; he had a jell sale
he fled; she led; she had jade; he had a ejll sale
Figure 11-1
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Figure 11-2
Summary Report (partial)
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Student Name
Class ID: 101
Dec. 2, 20—
MicroType
Alphabetic Keyboarding Summary
Build
Skill
Key-A-Shot
Date
Conditioning Keys Combine
Improve Average/ Average/
__#__
Completed Practice Learned Keys
Keystroking Fastest Fastest
Score
29/30
194
1
11/27/—
n/a
Home Row
ü
ü
30/36†
Review
n/a
ü
28/31
28/30
256
2
11/28/—
ü†
3
11/28/—
ü
h, e
ü
ü
31/37
30/32
194
4
11/29/—
ü
i, r
ü
ü
33/38
34/39
228
Review
n/a
ü
35/38
36/40
220
5
11/30/—
ü†
6
12/03/—
ü
o,t
ü
ü
36/42
36/41
152
7
—
—
—
—
—
—
—
8
—
—
—
—
—
—
—
9
—
—
—
—
—
—
—
10
—
—
—
—
—
—
—
11
—
—
—
—
—
—
—
12
—
—
—
—
—
—
—
13
—
—
—
—
—
—
—
14
—
—
—
—
—
—
—
†
Backspace key used in this section
n/a
Lesson part does not appear in this lesson
Note:
Average and fastest speeds are in gwam
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4. Students cannot access the Reports menu while working with the Open Screen or
Diagnostic Writings options.
5. When students choose to print a report, they can select to print only certain pages.
Keypad Timed Writings
The Keypad Timed Writings report, shown in Figure 11-3 on page 83, includes a
summary of a students work for the Keypad Timed Writings option. The most recent
performance information (fastest kspm, average kspm, and error rate) for each timed
writing appears on this report along with the actual data keyed.
Top Ten Lists
The Top Ten Lists option in the Reports menu displays a list of the top ten best scores
achieved for the games within the lessons. (See Figure 11-4 on page 84.) There are three
separate top ten listsKey-A-Shot, Connect It, and Worldwide Shipping. The top ten
lists include the following information: student name, date, score, average speed, fastest
speed, goal, and drill lines (sets) keyed.
NOTES:
1. MicroType 3.0 saves the top ten information in a folder (directory) called TopTen in the
program directory. You can delete the file in this folder to clear the top ten list data.
2. If the program is stored on a network, all students must have write-access and modify
privileges to the TopTen folder so that the program can update this information. The
Top Ten List will be empty if the program cannot write the scores to the network.
Certificate of Completion
The Certificate of Completion lists how many lessons from the various keyboarding
modules a student completed. The report also includes the students name, current date,
and the average speed for each module.
Performance Graphs
On the Lesson Report, click the Graph button to view the Performance Graph. (See
Figure 11-5 on page 84.) When a student accesses a Performance Graph from a Lesson
Report screen, the current lesson number is highlighted with a blue box. Alternatively, a
student can access all of the performance graphs from the Reports menu.
The MicroType 3.0 program provides several graphs so that students can visually review
their keyboarding performance. For each module, there are at least two performance
graphs. Alphabetic Keyboarding, for example, includes a graph that shows the average/
fastest speed for the Build Skill lesson part and another graph that presents the speed data
for the Key-A-Shot game. To print a graph, click the Print button. After reviewing the
results, click the Close button to close the window.
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Student Name
Class ID: 101
Dec. 14, 20—
MicroType: Keypad Timed Writings
Date
Completed
12/10/—
12/11/—
12/11/—
12/12/—
12/12/—
12/13/—
12/14/—

Group
Group 1: Home Row †
Group 2: Top Row †
Group 3: Bottom Row
Group 4: All Rows, (no decimals)
Group 5: All Rows, (with decimals)
Group 6: Mixed Lengths, (no decimals)
Group 7: Mixed Lengths, (with decimals)
Group 8: Long Random Numbers (no decimals)
Group 9: Long Random Numbers (with decimals)
Supplemental Group 1:
Supplemental Group 2:
Supplemental Group 3:
Supplemental Group 4:
Supplemental Group 5
†

Fastest Average
Speed Speed Error
(kspm) (kspm) Rate
225
211
5%
221
205
11%
229
210
14%
236
221
9%
238
219
10%
240
222
12%
241
225
8%

Backspace key used in this group

Group 1: Home Row
Original
4
4
4
5
5
5

6
6
6
0
0
0

44
44
44
55
55
55

66
66
66
44
55
66

40
40
40
50
50
50

60
60
60
40
50
60

400
400
400
400
500
500

600
600
600
400
500
600

45
56
64
54
46
65

404
505
606
506
506
606

6
6
6
0
0
0

44x
44
44
55
55
55

66
66
66
44
55
66

40
40
40
50
50
50

60
60
60
40
50
60

400
400
400
400
500
500

600
600
600
400
500
600

45
56
64
54
46
65

404
505
606
506
506
606

Student’s
4
4
4
5
5
5
::
::
Figure 11-3

::
::

::
::

::
::

::
::

Sample Keypad Timed Writings Report
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MicroType: Key-A-Shot
Top Ten List
Nov. 29, 20—

Student
1
Beth Hoffert
2
Lisa Wallace
3
Juan Martinez
4
Marcus Johnson
5
Mark Faber
6
7
8
9
10
Figure 11-4

Figure 11-5
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Date
11/27/—
11/22/—
11/28/—
11/25/—
11/29/—

Score
266
254
252
206
188

Average Fastest
Speed Speed
(gwam) (gwam)
38
45
38
42
37
42
35
38
33
38

Game
Drill
Goal
Lines
(gwam) Keyed
35
6
35
6
34
6
30
6
30
6

Sample Top Ten List (Key-A-Shot)

Sample Performance Graph
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SECTION 12

TEACHER UTILITIES

The teacher utilities provide several options that let you customize the MicroType 3.0
keyboarding software. For example, you can change a particular students information
(name, Class ID, password, and preferences) or you can change the Preferences for the
entire class. The teacher utilities also provide the capability to prepare a Class Summary
Report, review student progress, create diagnostic writings, create keypad timed writings,
set data locations, and change your password.
Access the teacher utilities through the Student Log In dialog box. Hold down the
ALT key (Windows) or OPTION key (Macintosh) and click the OK button. Enter
mtype3 for the password to display the options shown in Figure 12-1.

Figure 12-1

Teacher Utilities Main Menu

IMPORTANT: If the program is installed on a network, you must have write-access
privileges to the program directory. MicroType 3.0 saves the data location, teacher
password, default Preferences, and other information in the program directory. If you
dont have read/write access, you may not be able to update this information.
Update Student Information
Use the Update Student Information option to add a new student, edit student
information (name, password, Class ID, and preferences), delete student files, and import/
export student records. When you choose this option, the dialog box shown in Figure 122 appears on your screen.
Edit a Student Record
When students first use the MicroType 3.0 software, they must enter their names, Class
IDs, and passwords. Once entered, students cannot change their names or Class IDs.
However, you, the teacher, can edit any of this information. (See Figure 12-3.)
1. Choose the Update Student Information option from the Teacher Utilities menu.
2. Highlight the student name in the list. You can narrow down the search by changing
the Class ID to display only those students in a particular class.
Section 12 Teacher Utilities
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Figure 12-2

Teacher Utilities (Update Student Information)
Figure 12-3 Edit Student
Dialog Box

If your students store their performance data on a network server, you can access all
students record from any computer. Otherwise, you must use the computer on which
the students record is stored. If your students save their work on a floppy disk, insert
the students disk into the drive and use the Folder button to choose the floppy drive.
3. Click the Edit button.
4. Change the students name, Class ID, or password.
5. If you want to change the students preferences, click the Preferences button as
shown in Figure 12-3.
6. Select the Override class preferences radio button, then select the preferences
settings. Click the Lock button to lock/unlock the corresponding preferences
category. Click OK to accept the new preferences.
7. Click the OK button in the Edit Student dialog box to accept all of the changes.
NOTE: You cannot change the location of a students record with the Edit option.
If your student specified the wrong data location when he/she logged in for the first
time, simply copy the students performance record to the correct location.
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Add a New Student Record
If you prefer, you can enter all of the student records instead of having your students
perform these steps.
1. Choose the Update Student Information option from the Teacher Utilities menu.
2. Click the New button in the Edit Student dialog box.
3. Enter the students name (first name, last name).
4. Record a Class ID.
5. Enter the students password.
6. Specify the data location if necessary.
If you created a separate folder for each student, set the path accordingly. You can
click on the Folder icon to browse through the folders. If you want the student to
save his/her work on a floppy disk, insert a blank formatted disk into the drive now.
7. If necessary, click the Preferences button and update the required information.
8. Click the OK button to create the new student record.
Delete a Student Record
If you want to delete numerous student records, the best way is to simply delete the
files using the operating system utilities. However, you can delete student records one at
a time by following these steps.
1. Choose the Update Student Information option from the Teacher Utilities menu.
2. Highlight the student whose record you want to delete.
If your students store their performance data on a network server, you can access all
of the students records from any computer. Otherwise, you must use the computer
on which the students record is stored. If your students save their work on a floppy
disk, insert the students disk into the drive and use the Locate feature to choose the
floppy drive.
3. Click the Delete button and respond to the prompt that you want to delete the
student record.
Import/Export Student Records
MicroType 3.0 provides an option for you to import and export existing student
records. The import and export features in MicroType 3.0 allow you to import an existing
class list or export your MicroType 3.0 class list to a text (.txt) document. Class lists that
you import must be in text. (.txt) file format. If you already have a class list as a text
(.txt) file, using the import feature can be more efficient than creating new student
records manually.
NOTE: Word processing documents can be easily converted to .txt files and then
imported into MicroType 3.0. Consult your word processing documentation for instructions on saving files in .txt file format.
Follow the steps below to import/export class lists:
Section 12 Teacher Utilities
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Importing a Class List
1. Choose the Update Student Information option from the Teacher Utilities menu.
2. Click the Folder icon to set the location where you would like the student records
imported.
3. Click the Import button.
4. Locate and select the text (.txt) file that contains your class list and click Open.
NOTE: If a student record already exists in MicroType 3.0, that students information
will not be imported.
IMPORTANT: The text file that contains the class list must be formatted using the
list of rules/guidelines below. Failure to follow the guidelines will result in an error when
importing your class list text file.
1. Each student name must be formatted as follows:
<last name>,<first name>,<class name>,<password>
Example:
Lopez,Tina,Class A,password
Smith,James,Class A,password
2. All four fields are required for each student name. If students are not assigned to a
class, leave the class field empty.
Example:
Lopez,Tina,,password
3. Each field length must not exceed the maximum number of characters, listed below.
Exceeding the required field length will cause the students name to be skipped during
import.
Last name

20 characters

First name

20 characters

Class name

25 characters

Password

15 characters

4. In a case where a students name, class, or password includes a comma (,), the
comma must be preceded by a backslash (\).
Example:
Smith\, Jr.,James,Class A,password
Exporting a Class List
1. Choose the Update Student Information option from the Teacher Utilities menu.
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2. Select a class from the Class ID drop-down menu. (Choose No Class Assigned if youd
like to export all of the students.)
3. Click the Export button.
4. Select the location where you would like to save the class list text (.txt) file and create
a filename. (MicroType 3.0 will automatically add a filename extension (.txt) to the
end of the filename.)
5. Click Save.
Review Student Progress
Using the Review Student Progress option you can check the progress for any of your
students. Simply select a student and choose a report to review. You can choose any of
the reports that students may access in the tutorial. Click the OK button to display the
report. Close the report window and select another student and/or report.
Update Class Preferences
Use the Update Class Preferences option to change the preferences for all of your
students or only the students in a pre-defined class.
NOTE: Using the Update Class Preferences feature is not recommended if your
students save their work on floppy disks. Rather, use the Update Student Information option
to make changes to individual records.
The Preferences are presented in Figure 12-4. While you have access to all the options
listed here, your students see only some of these option. Only those options marked by
an asterisk in the following list are accessible to your students.

Figure 12-4 Teacher Utilities (Preferences)
A brief explanation of the Preferences options and the default settings are presented
here.
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Default
Preference
General
Show Lesson Movies (On)*
Play Movie Audio (On)*
Play Narration/
Effects Audio (On)*
Bookmark (On)*
Allow Game Access (Yes)
Allow Students to
Change Password
Two Spaces After
End Punctuation (On)*
Create Sub-folder For
Each Student (On)

Language (English)*

Teacher Email Address
(no data)*
Alphabetic Keyboarding
Accuracy Rate (50%)

Backspace Allowed (Yes)*
Game Goal (15 gwam)

Game Drill Lines (6)
Game Delayed Action
(Off)*
90

Description
This options controls whether the movies can be played in
the lessons.
This option controls whether audio is played with the
movies. If you do not have a sound card, this option should
be disabled.
This option controls whether the narrative audio
and sound effects play throughout the program. If you do
not have a sound card, this option should be disabled.
The program prompts the student to continue where he/she
left off if this option is enabled.
If you turn this option off, the program will not allow your
students to access any of the games.
If you turn this option off, the program will not allow your
students to change their passwords
If this option is enabled, the program will
automatically put two spaces after each period.
This options controls whether or not a sub-folder
with the students name is created within the student folder.
This sub-folder will contain the student file (.swk). In
addition, students can save all diagnostic writing and word
processor documents in this folder.
This option controls whether the narrative audio and onscreen text play/appear in English or Spanish. Only the
technique hints, emphasis, and on-screen instructions are
available in Spanish.
No Data Use this field to add/change your email address.
This information is necessary for students to use the Send
File feature. (Windows only.)
The accuracy rate option determines the minimum accuracy
requirement for the drills used in certain lesson parts. This
option prevents students from simply entering garbage
during a drill.
If this option is on, students are allowed to use the
BACKSPACE/DELETE key in selected lesson parts.
The Key-A-Shot game sets the game goal using this option
only when a student does not complete a Build Skill part
within any of the Alphabetic Lessons. Normally, the game
goal is calculated to be approximately 90% of the average
Build Skill speed for all Alphabetic Build Skill lesson parts
completed.
This option controls the number of drill lines presented in a
Connect It session.
The normal mode for the Key-A-Shot game is real-time
action. Students can play in delayed action if you turn this
option on.
MicroType 3.0 Users Guide

Automatically Select
Lesson Mode (On)

Numeric Keyboarding
Accuracy Rate (60%)

Backspace Allowed (Yes)*

Game Goal (15 gwam)

Game Drill Lines (6)
Max Seconds Earned
Per Line (30)

Keyboarding Skill Builder
Accuracy Rate (50%)

If this option is on, MicroType 3.0 will automatically suggest
an Alphabetic Keyboarding lesson mode for students after
they complete the Skill Analysis timed writing during the log
in process. If this option is turned off, students will be
assigned to the lesson mode that you select, regardles of their
results on the Skill Analysis.

The accuracy rate option determines the minimum accuracy
requirement for the drills used in certain lesson parts. This
option prevents students from simply entering garbage
during a drill.
If this option is on, students are allowed to use the
BACKSPACE/DELETE key in selected drills. This option
also controls whether or not students can use the BACKSPACE/DELETE key when choosing Diagnostic Writings
from the Numeric Keyboarding Lesson menu.
The Connect It game sets the game goal using this option
only when a student does not complete a Build Skill part
within any of the Numeric Lessons. Normally, the game goal
is calculated to be approximately 90% of the average Build
Skill speed for all Numeric Build Skill lesson parts completed.
This option controls the number of drill lines presented in a
game session.
This option controls how much game time a student earns
for completing a drill line. Use this option to adjust the
difficulty of the game. For example, if students find the
game too difficult, increase the number of seconds they earn
for completing a drill line.

The accuracy rate option determines the minimum accuracy
requirement for the drills used in certain lesson parts. This
option prevents students from simply entering garbage
during a drill.
Backspace Allowed (Yes)*
If this option is on, students are allowed to use the
BACKSPACE/DELETE key in selected drills. The option
also controls whether or not students can use the BACKSPACE/DELETE key when they choose Diagnostic
Writings from the Skill Builder Lesson menu.
Show Time Remaining (On)* A count-down timer appears for some lesson parts if this
option is on.
Timer Sound (On)*
Use this option to turn on/off the beep that the program
plays during the course of a timing. This option controls the
sound in the tutorial section only. The word processor
includes separate options to enable a time sound.
Section 12 Teacher Utilities
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Emphasis (Speed)*
Numeric Keypad
Accuracy Rate (50%)

Backspace Allowed (Yes)*
Game Goal (75 kspm)

Game Drill Lines (6)
Game Delayed Action
(Off)*
Quick Review
Accuracy Rate (50%)

Backspace Allowed (Yes)*

Open Screen
Paste Allowed (Yes)*

With this option, the Skill Builder section can be used to
focus on speed or on accuracy.
The accuracy rate option determines the minimum accuracy
requirement for the drills used in certain lesson parts. This
option prevents students from simply entering garbage
during a drill.
If this option is on, students are allowed to use the
BACKSPACE/DELETE key in selected drills.
The Worldwide Shipping game sets the game goal using this
option only when a student does not complete the Build Skill
section of the lesson. Normally, the game uses 90% of the
average rate achieved in the Build Skill section for the game
goal.
This option controls the number of drill lines presented in a
Worldwide Shipping session.
The normal mode for the Worldwide Shipping game is realtime action. Students can play in delayed mode if you turn
this option on.
The accuracy rate option determines the minimum accuarcy
requirement for the drills used in certain lesson parts. This
option prevents students from simply entering garbage
during a drill.
If this option is on, students are allowed to use the
BACKSPACE/DELETE key in selected drills. This option
also controls whether or not students can use the BACKSPACE/DELETE key when choosing Diagnostic Writings
from the Numeric Keyboarding Lesson menu.

If this option is on, students can use the Paste function
while working in the word processor.
Print Current Date and Time If this option is on, the current date and time will appear on
(Off)
all student word processor documents.
Backspace Allowed (Yes)*
If this option is on, students can use the BACKSPACE/
DELETE key while working with the Word Processor.
Backspace: Count-Down
If this is on, students can use the BACKSPACE/DELETE
Writings (Yes)*
key while keying count-down writings.
Backspace: Count-Up
If this is on, students can use the BACKSPACE/DELETE
Writings (Yes)*
key while keying count-up writings.
Count-Down Writings:
This option controls whether the program uses single-spaced
Spacing (Single)*
lines or double-spaced lines for count-down timed writings.
Default Style: Font/Size
The program uses these settings as the default font and size
(Times, 11pt)*
for new word processor documents, count-down timings,
count-up timings. These settings do not affect the Diagnostic Writings font/size. If you want to change the default
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Skill Analysis
Require Skill Analysis
Test at Login (No)
Lesson Mode Requirements
(Refresher mode:
25 gwam/90%)
(Skillbuilder mode:
45 gwam/95%)
Timing Length (3 minutes)

font/size for the Diagnostic Writings, use the Create
Diagnostic Wrtings teacher utility option to edit the existing
writings. Change the font and size for the diagnostic writings
and then save the updated writings. When a student takes a
diagnostic writing, the program will apply the font/size that
was used for the diagnostic writing source copy.
This option controls whether or not students are required to
take the Skill Analysis timed writing at login. If this option
is set to No, students have the option of declining the Skill
Analysis timed writing.
This option controls the minimum requirements that
students must achieve on the Skill Analysis timed writing in
order to be recommended for the Refresher mode or
Skillbuilder mode. Students who do not meet the
minimum requirements for the Refresher mode will be
recommended to complete the lessons in New Key Learning
mode.
Use this option to set the timing length for the Skill Analysis
timed writing.

To change Preferences:
1. Choose Update Class Preferences from the Teacher Utilities menu.
2. Highlight a class and click the Edit button.
3. Click the various options to set the keyboarding software Preferences as desired. If
you want to prevent students from changing the preferences you set, click the Lock
button(s).
NOTE: Remember that the options that your students see when they choose the
Preferences are only a subset of those shown in Figure 12-4.
4. Click the OK button to save the updated class preferences.
NOTE: When you change the preferences for a class, the software automatically
applies the new settings to all of the students in the class the next time they log in.
IMPORTANT: When you save the preferences, the program writes this information
to the MicroType 3.0 Options directory. If the program is installed on a network, you
must have write and modify access privileges to the MicroType 3.0 Options directory.
If the program is installed on individual computers, you must change the class
preferences at each workstation.
5. If you ever want to restore the preferences to the default settings, click the Restore
button. To apply these restored settings to your class, click the OK button.
Click the Cancel button to exit the Preferences dialog box.
Prepare Class Summary Report
The Class Summary Report provides an overview of your students progress using the
MicroType 3.0 software. Five Class Summary Reports are available: Alphabetic Keyboarding, Numeric Keyboarding, Keyboarding Skill Builder, Numeric Keypad, and
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Diagnostic Writings. A sample report is shown in Figure 12-5.
The Skill Analysis summary report shows the students initial Skill Analysis timed
writing attempt and the students five most recent attempts. You can use this information
to assess student progress while using MicroType 3.0.
The lesson reports (Alphabetic, Numeric Keyboarding, Keyboarding Skill Builder, and
Numeric Keypad) include a list of the lessons available in each section and the students
average gwam speed for each Build Skill or Measurement Writing (Skill Builder) lesson
part. The entire lesson (including all lesson parts) must be completed before the average
gwam is shown. Lessons containing no data () have not been completed.
The program uses the Build Skill data to calculate the average speed results for
Alphabetic Keyboarding, Numeric Keyboarding, and Numeric Keypad columns. The
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Note: Each column shows the student’s average speed (gwam) for Build Skill in the lesson.

Lessons conatining no data (--) have not been completed.

7
23
20
19
24
-::
6
22
19
19
24
19
::
5
22
20
20
24
19
::
4
22
19
19
24
17
::
1-20)
2
3
20 20
18 18
19 19
22 22
17 19
::
::
Alphabetic (Lessons
Student
1
Lisa Wallace
20
Beth Hoffert
18
Marcus Johnson 19
Juan Martinez
22
Mark Faber
17
::
::

Location: c:\Program Files\MicroType3\students

MicroType
Class Summary Report
Dec. 12, 20—

8
23
21
20
25
-::

9
24
23
20
25
-::

10
24
23
-25
-::

11
24
23
-26
-::

12
25
24
---::

13
25
24
---::

14
25
24
---::

Figure 12-5 Teacher
Utilities (Class Summary
Report)
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Keyboarding Skill Builder (Speed) results are calculated by using the fastest speed data
from the Measurement Writing section. The Skill Builder (Accuracy) averages are
computed by using the fewest errors data from the Measurement Writing activities.
The Diagnostic Writings Summary Report shows the students speed (gwam) and
number of errors for the students second attempt of the last four diagnostic writings.
Writings containing no data () have not been completed.
To create a class summary report:
1. Select a class from the Class ID drop-down list.
2. Select one of the five available reports.
3. Click the OK button.
4. Click Print if you want a printout of the report. Click the Close button when you
are done viewing the report on screen.
Create Diagnostic Writings
Use the Create Diagnostic Writings option to create additional diagnostic writings. This
option also allows you to edit or delete existing diagnostic writings.
1. Choose Create Diagnostic Writings from the Teacher Utilities menu.
2. Choose a paragraph writing of sufficient length that most students will not complete
in 5'but not over fifty lines. A textbook timed writing consisting of twenty-five to
thirty lines is appropriate.
3. Key the paragraphs.
4. The margins and tabs you set will automatically be set for the students.
5. Avoid hyphenating words at the end of a line. If students make errors that affect line
length, they may have to hyphenate words that should not be hyphenated in order to
have their words match the ones in the source copy.
6. As you enter paragraph copy, use the programs word wrap feature. Students will use
word wrap as they key. (If you wish to enter lines rather than paragraphs, the use of
ENTER/RETURN at the end of each line is appropriate; however, be sure to remind
students of this.
7. When you have finished keying the diagnostic writing, save it. (NOTE: If your
writing contains errors, open it using the teacher utilities and edit the document.)
8. When you are done creating a diagnostic writing, choose Exit Diagnostic Writings from
the File menu.
9. Copy the diagnostic writings to each computer if you are not on a network.
Create Keypad Timed Writings
Using the teacher utilities, you can add up to five supplemental keypad timed writings.
These timed writings are available to your students along with the standard group timed
writings by using the Timed Writings option on the Numeric Keypad Lesson menu. After
you enter a supplemental timed writing, you can edit it as many times as you want.
Add/Edit a Supplemental Keypad Timed Writing
1. Select the Create Keypad Timed Writings option from the Teacher Utilities menu.
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95

2. Choose a supplemental timed writing (1-5) to add or edit. If the selected keypad
timed writing in the current data location already contains figures, an asterisk or check
mark appears next to the timed writing name.
3. Enter the figures for a new timed writing or change the information in an existing
timed writing. (See Figure 12-6.)
4. Click the Record button to save the supplemental timed writing.
5. Click the Done button when you finish creating/editing keypad timed writings.
NOTE: The program saves the supplemental timed writings as part of the preferences
file. If the keyboarding software is not running from a network server for everyone to
access, you must copy the preferences file to the program folder on each computer.
Figure 12-6 Teacher
Utilities (Add/Edit Keypad
Timed Writing)

Set Data Locations
The MicroType 3.0 software needs to know the location where you want to save your
students records, which contain their performance data. It also must have the location
of the default Preferences, keypad timed writings, and diagnostic writings. Both of these
data locations should be set before your students use the program.
Review the information for recording student data presented in Section 4 Preparing to
Use the Keyboarding Software beginning on page 13. This material discusses several alternatives for saving student data. Depending on the option you choose, you may or may not
have to change the data locations. If you must change either data location, click the
Override default folder radio button and then enter the path in the space provided or click
the Folder button to locate the path.
The Set Data Locations dialog box (Figure 12-8) also includes the options to disable
the New User and Guest buttons in the Student Log In dialog box. Initially, the
program allows students to use these buttons, but you may find it necessary to disable
them.
NOTE: If you change the data locations, you most likely will need to make the same
change at each computer. Changes to the status of the New User or Guest button must
be made at each computer unless the program is running from a network server.
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Change Teacher Password
The MicroType 3.0 program initially sets the teacher password to mtype3 so that you
can access the teacher utilities. However, you can change the password at any time by
using the Change Teacher Password option. To change the password, you must enter the
current password and the new password. Be sure to remember the new password. Once
you change it, the default password (mtype3) is no longer valid.
NOTE: Changing the teacher password applies only to the computer that you used to
record the new password unless the MicroType 3.0 program is installed on a network
server. The same password must be used by all teachers using the same copy of the
program.
Remember that you access the teacher utilities through the Student Log In screen.
Hold down the ALT (Windows) or OPTION (Macintosh) key and click the OK button.
Then enter the password.

Figure 12-7

Teacher Utilities
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SECTION 13

SEND FILE (Windows)

MicroType 3.0 provides the student a convenient way to send his/her data files to a
teacher through his/her existing email program. This is very useful for a student in a
distance learning environment who is not in the same location as the teacher. The Send
File feature gives the student the ability to send his/her work to the teacher for evaluation.
For the student to use Send File, a MAPI-compliant email program must be installed
and properly configured on their computer. MAPI stands for Messaging Application
Program Interface. MAPI is a Microsoft Windows program interface that enables the user
to send email from within a Windows application and attach a users document to the email. Some examples of MAPI compliant email packages are Microsoft Outlook,
Microsoft Exchange, Lotus CC:Mail, Microsoft Mail, Eudora Pro, Netscape Messenger,
Novell Groupwise, Banyan BeyondMail, and Hewlett Packard OpenMail.
America Online is an email program that will not work with Send File because it is
currently not MAPI compliant. Internet-based email packages such as Hotmail, Juno, and
Yahoo! Mail will not work because these programs reside at a Web site rather than on a
students computer.
If your student has an email package that is not MAPI compliant or that is Internetbased, as long as the students email program allows attachments, he/she can still send the
data files manually as attachments to a regular email message. To send a file manually,
students should attach their data files (surname.swk) to an email addressed to you. By
default, the student file is saved in the directory c:\Program Files\MicroType3\Students
Sending a Student File
To use the Send File feature, the student must do the following:
1. Register (log in) as a student.
2. Click the Send File button on the Main menu or the Lesson Report menu for each
lesson.
3. The student data file is automatically attached to the email. To attach additional files,
click the Attach button and locate the files you wish to add.
4. Click the Send button.
NOTE: Before using the Send File feature, students must enter the teacher email
address into Student Preferences. Alternatively, you can save your email address into the
class preferences using the teacher Preferences option.
Retrieving a Student File
Whether students send their data file manually or by using the Send File feature, the
steps to retrieve and view it are the same. To retrieve a student file, the teacher must do
the following:
1. Use your email program to get the student email. (Please refer to your email packages
user documentation for more detailed instructions on how to get mail.)
2. Detach the students data file from your email message (e.g. John Franklin.swk).
(Please refer to your email packages user documentation for more detailed instructions
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on how to detach an attachment from an email message.) Copy the students data file
into the folder where you are storing the student files. (The default is c:\Program
Files\MicroType3\Students.)
3. Use the reporting features available in Teacher Utilities to generate student reports.

Figure 13-1

Send File Window

Section 13
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APPENDIX A

TROUBLESHOOTING TIPS

If you or your students experience difficulty using the MicroType 3.0 software, refer to
the information given in this appendix to correct the problem.
Windows
A student forgets his/her password.
Use the Update Student Information option in the Teacher Utilities to access (edit) the
students record. The password appears in the dialog box.
You forget the teacher password.
The default password is mtype3. However, this password will not be valid if you
changed your password. Call the Technical Support Hotline for further assistance.
The program seems to stop working when students learn a new key or while keying drill lines.
First, make sure that CAPS LOCK is not enabled when entering alphabetic keys. Turn
CAPS LOCK off and then try striking the key (a to z). While using the keypad, the NUM
LOCK option should be on.
The screen fonts do not seem appropriate, or the reports are not aligned properly.
The MicroType 3.0 software requires the following TrueType fonts: Arial, Courier New,
Symbol, Times New Roman, and Wingdings. These fonts are usually installed on all
computers at the factory. (For Advanced Users Only) If the fonts are not installed, copy
them to the computer and use the Fonts control panel to complete the installation
process.
The program replaces selected fonts in an Open Screen document with other fonts.
The fonts used by word processing programs such as the Open Screen are stored on
each computer. Only those fonts available on any given computer may be used in a
document. If a student creates a document with a unique font (e.g., Century Gothic) that
is available on only one computer in the lab, the program will replace that font with
another when the student opens that document on a different computer. To resolve this
problem, make sure that all the computers in the lab have the same fonts. Alternatively,
instruct your students to work with only those fonts that are common to the computers
that they use.
While attempting to save an Open Screen or Diagnostic Writing to a network server, the program
displays a message indicating that you do not have modify privileges.
Make sure that each student has the following access privileges to his/her directory:
read (R), write (W), erase (E), create (C), file scan (F), and modify (M). Students need
only read (R) and file scan (F) access for those directories from which they will only read
files.
Working with the Teacher Utilities to create a diagnostic writing to a network server, the program
indicates that you do not have modify privileges.
Make sure that you, the teacher, are assigned the following privileges to the directory
where you plan to save the new diagnostic writings: read (R), write (W), erase (E), create
(C), file scan (F), and modify (M).
The movies are slow and not very responsive.
Turn off the show lesson movies, play movie audio, and play narration/effects audio
preferences if the animations are slow. Although the program attempts to detect if your
computer has the appropriate sound capabilities, this detection process is not foolproof.
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Disabling the sound option should significantly improve the animation speed in these
cases.
If you have the program installed on a network server, you may experience problems
with the movies if your network is not fast enough to deliver the large movies files to all
of the workstations. A 100Mb network is strongly recommended. Disable the show
lesson movies option if the problem persists.
The program does not access the movies when the system was configured to play the movies from the
CD-ROM.
When you install the software, you have the option to install the movies to the hard
drive/network, or leave the movies on the CD-ROM. Each time prior to running the
keyboarding software, you must insert the CD-ROM into the disc drive. If the MicroType
3.0 program does not find a movie because the CD-ROM was not available, the tutorial
will skip that movie.
If you do have the CD-ROM in the drive, but the program does not access the movie,
try to re-install the program. Your configuration may have changed causing the program
not to be able to find the movies. (Advanced users may want to edit the INI file.)
The sounds generated by the program do not seem to function properly.
Use the Preferences option to turn off the play movie audio and play narration/effects
audio preferences. A sound card is required for best results to play the sounds that
accompany the animations.
Delivering streaming audio over a slow network may result is some problems. A
100Mb network is strongly recommended. Disable the audio option if the problem
persists.
When a student accesses the Diagnostic Writings or Timed Writings options, some or all of the files
do not appear in the list.
If you created new diagnostic writings or keypad timed writing timed writings, make
sure that you copied them to the correct location. Use the Set Data Locations option in the
teacher utilities to view/change the location where the programs looks for these files. If
you changed the data location to a network server, you may have to change this information at each computer and then manually copy the diagnostic writings and timed writings
to the server. As a temporary measure, have your student use the Folder button to
identify the location of the files.
When a student starts the program, no student names appear in the list.
If you changed the data location using the teacher utilities, you must manually copy
the student records to the new location. The Log In screen looks in the location set in the
teacher utilities to find the students records. If your students save their work to Drive
A, they may need to use the Folder button to set the location to a floppy disk.
The program requires several minutes to display the student list in the Log In dialog box.
If you are storing the student performance data on a network server, you may
experience delays if there are more than 500 directories in the student data directory. For
example, suppose that the data directory is set to h:\students that includes a data
directory for each student in the entire school. The MicroType 3.0 software searches all of
the directories in the h:\students folder to find those students who have a keyboarding
record. If there are quite a few student subdirectories (e.g., 500 or more), this process
may take a few moments. To solve this problem, you may want to create a new directory
(e.g., x:\keyboard\students). Then, copy all of the students keyboarding files (.swk) to
the new directory. Be sure to set the data location using the teacher utilities. The log in
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process will be much faster now since the program needs to look in only one directory to
find all of the students. Even though you make this change, you can still direct your
students to save their Open Screen and diagnostic writing documents in their own data
directory.
Students receive an error message when trying to save their work to a network.
Make sure that students have read/write access to the drive and subdirectory where
they are trying to save their work. Using the Set Data Locations option in the teacher
utilities, verify that the student data location is set properly.
The MicroType 3.0 program will not allow you to save a new diagnostic writing that you
created using the teacher utilities.
Make sure that you have read/write access to the drive and subdirectory where you are
trying to save the diagnostic timed writing. Using the Set Data Locations option in the
teacher utilities, verify that the data location is set properly.
The students scores do not appear in the Top Ten Lists.
MicroType 3.0 saves the top ten data in a directory called topten in the program
directory. If the software is installed on a network, you must give each student writeaccess privileges to that directory. Otherwise, the program will not be able to save the
data to the network hard drive and consequently the game reports will not show any
results. All other student data are stored in the individual student directories.
How do I delete the Top Ten Lists?
To erase the top ten lists, delete the file in the topten directory. This directory is
located with the other program files. Do not delete the directory, only its contents.
How do I uninstall the MicroType 3.0 software?
The installation program installs most of the programs in the Program Files\
MicroType3 directory unless you changed the directory during the installation process.
To uninstall MicroType 3.0 , select Uninstall MicroType 3.0 from the South-Western Keyboarding Program group. If files remain after you run the uninstall, simply delete all of the files
and subdirectories in the MicroType 3.0 directory. Delete the student files, too.
The Send File is bringing up an email program screen different from my email program.
The Send File program is finding another MAPI-compliant email program on the
computer. Check the email packages user documentation to make sure your email
program is MAPI-compliant and properly configured. If it is, consult the users documentation or the email programs manufacturer on how to set your email program as the
default email package for your computer.
The Log In screen is not displaying all the students in the list.
The program has a limit of 3,000 students. Any more than 3,000 will not display in
the list.
The New button in the Update Class Preferences window is dimmed and not accessible.
The program has a limit of 14 classes. Once this limit is reached, the program will
not allow any more.
When accessing Teacher Utilities, the program displays a message indicating that the file is in use.
In order to prevent teachers from simultaneously editing student and class information,
the program will allow only one teacher to access teacher utilities at a time.

102

MicroType 3.0 Users Guide

Macintosh
A student forgets his/her password.
Use the Update Student Information option in the Teacher Utilities to access (edit) the
students record. The password appears in the dialog box.
You forget the teacher password.
The default password is mtype3. However, this password will not be valid if you
changed your password. Call the Technical Support Hotline for further assistance.
The program seems to stop working when students learn a new key or while keying drill lines.
First, make sure that CAPS LOCK is not enabled when entering alphabetic keys. Turn
CAPS LOCK off and then try striking the key (a to z). While using the keypad, the NUM
LOCK option should be on.
The screen fonts do not seem appropriate or the reports are not aligned properly.
The MicroType 3.0 software requires all sizes of the following fonts: Chicago, Comic
Sans, Courier, Geneva, Helvetica, Monaco, and Times. These fonts are usually installed
on all computers at the factory. (For Advanced Users Only) If the fonts are not installed,
copy them to the computer and use the Fonts control panel to complete the installation
process. If you do not have Comic Sans, you may be able to download this font from the
Microsoft website.
The program replaces selected fonts in a word processor document with other fonts.
The fonts used by word processing programs such as the word processor are stored on
each computer. Only those fonts available on any given computer may be used in a
document. If a student creates a document with a unique font (e.g., Century Gothic) that
is available on only one computer in the lab, the program will replace that font with
another when the student opens that document on a different computer. To resolve this
problem, make sure that all the computers in the lab have the same fonts. Alternatively,
instruct you students to work with only those fonts that are common to the computers
that they use.
The MicroType 3.0 program stops working during animations or does not start-up.
First, verify that the installation process was performed correctly and that the
keyboarding files have not been erased. Verify that the monitor options are set to display
256 colors (or higher).
When you start the application, a message indicates that there is not enough memory.
A minimum of 32MB memory is required to run the MicroType 3.0 application. If you
dont have enough physical memory, try using the Memory control panel to turn on virtual
memory. Restart the computer and then try to launch the keyboarding software.
Note: Even though a computer may have 32MB total memory, some of the memory is
used for the system software and its extensions. Depending on your configuration, the
system software requirements may not leave enough free memory for other applications.
Using virtual memory should help in these situations.
The movies are slow and not very responsive.
Turn off the show lesson movies, play movie audio, and play narration/effects audio
preferences if the animations are slow. Although the program attempts to detect if your
computer has the appropriate sound capabilities, this detection process is not foolproof.
Disabling the sound option should significantly improve the animation speed in these
cases. Also, make sure that QuickTime 4.0 (or a more recent version) is installed.
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If you have the program installed on a network server, you may experience problems
with the movies if you network is not fast enough to deliver the large movies files to all
of the workstations. A 100Mb network is strongly recommended. Disable the show
movies option if the problem persists.
The program does not access the movies when the system was configured to play the movies from the
CD-ROM.
When you install the software, you have the option to install the movies to the hard
drive/network, or leave the movies on the CD-ROM. Each time prior to running the
keyboarding software, you must insert the CD-ROM into the disc drive. If the MicroType
3.0 program does not find a movie because the CD-ROM was not available, the tutorial
will skip that movie.
If you do have the CD-ROM in the drive, but the program still does not access the
movie, try to re-install the program. Your configuration may have changed causing the
program not to be able to find the movies.
The sounds generated by the program do not seem to function properly.
Use the Preferences to turn off play movie audio and play narration/effects audio
preferences.
Delivering streaming audio over a slow network may result is some problems. A
100Mb network is strongly recommended. Disable the audio option if the problem
persists.
When a student accesses the Diagnostic Writings or Timed Writings options, some or all of the files
do not appear in the list.
If you created new diagnostic writings or keypad timed writings, make sure that you
copied them to the correct location. Use the Set Data Locations option in the teacher
utilities to view/change the location where the programs looks for these files. If you
changed the data location to a network server, you may have to change this information at
each computer and then manually copy the diagnostic writings and timed writings to the
server. As a temporary measure, have your student use the Folder button to identify the
location of the files.
When a student starts the program, no student names appear in the list.
If you changed the data location using the teacher utilities, you must manually copy
the student records to the new location. The Log In screen looks in the location set in the
teacher utilities to find the students records. If your students save their work to a floppy
diskette, they must use the Folder button to set the data location.
Also, check the General Controls control panel. Make sure that the When opening or
saving a document, take me to: option is set to the folder which contains the application. If
this setting is not selected, the program may not use the student data location information
when it displays a standard Open or Save dialog box.
The program requires several minutes to display the student list in the Log In dialog box.
If you are storing the student performance data on a network server, you may
experience delays if there are more than 500 folders in the student data folder. For
example, suppose that the data location is set to Network:Students and this location
includes a data folder for each student in the entire school. The MicroType 3.0 software
searches all of the folders in the Network:Students location to find those students who
have a keyboarding record. If there are quite a few student folders (e.g., 500 or more),
this process may take a few moments. To solve this problem, you may want to create a
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new folder on the network (e.g., Network:South-Western Keyboarding:Student
Data). Then, copy all of the students keyboarding files to the new folder. Be sure to set
the data location using the teacher utilities. The log-in process will be much faster now
since the program needs to look in only one folder to find all of the students. Even
though you make this change, you can still direct your students to save their word
processor and diagnostic writing documents in their own data folder.
Students receive an error message when trying to save their work to a network.
Make sure that students have read/write access to the drive and folder where they are
trying to save their work. Using the Set Data Locations option in the teacher utilities,
verify that the student data location is set properly.
The MicroType 3.0 program will not allow you to save a new timed writing that you created using the
teacher utilities.
Make sure that you have read/write access to the drive and folder where you are trying
to save the timed writing. Using the Set Data Locations option in the teacher utilities,
verify that the data location is set properly.
The students scores do not appear in the top ten list game reports.
MicroType 3.0 saves the top ten data in a folder called Top Ten in the program folder.
If the software is installed on a network, you must give each student write-access
privileges to that folder. Otherwise, the program will not be able to save the data to the
network hard drive and consequently the game reports will not show any results. All
other student data are stored in the individual student folders.
How do I delete the Top Ten Lists?
To erase the top ten lists, delete the file in the Top Ten folder. This folder is located
with the other program files. Do not delete the folder, only the contents of the folder.
How do I uninstall the MicroType 3.0 software.
The installation process installs all of the program files in the South-Western
Keyboarding folder unless you specified a different location. Simply drag this folder to
the Trash Can and empty the trash. Delete the student files, too.
The Log In screen is not displaying all the students in the list.
The program has a limit of 3,000 students. Any more than 3,000 will not display in
the list.
The New button in the Update Class Preferences window is dimmed and not accessible.
The program has a limit of 14 classes. Once this limit is reached, the program will
not allow any more.
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APPENDIX B

TECHNIQUE CHECK SHEET

TECHNIQUE RATING SHEET
RATINGS AND GRADES
Excellent
Good
Average
Acceptable

4 points
3 points
2 points
1 point

(3.6-4.0)
(2.6-3.5)
(1.6-2.5)
(0.6-1.5)

=
=
=
=

A
B
C
D

=
=
=
=

93-100
85-92
78-84
70-77

Rating Periods
1

Position at keyboard .....................................

2

3

4

5

6

7

8

9

10

Rating

1. Sits in a comfortable, relaxed position directly in
front of keyboard......................................................
2. Keeps feet on floor for proper body balance ...........
3. Keeps elbows in relaxed, natural position at sides
of body .....................................................................
4. Keeps wrists low and relaxed but off frame of
keyboard ..................................................................
Keystroking....................................................

Rating

1. Keeps fingers well curved and upright over home
keys .........................................................................
2. Strikes each key with proper finger .........................
3. Keeps hands and arms quiet; wrists low .................
4. Makes quick, snappy keystrokes with immediate
key release ..............................................................
Space Bar.......................................................

Rating

1. Keeps right thumb curved and close to space bar ..
2. Strikes space bar with a quick, down-and-in (toward
palm) motion of thumb.............................................
3. Releases space bar instantly...................................
4. Does not pause before or after spacing stroke .......
Return/Enter key ...........................................

Rating

1. Returns quickly wherever a hard return is required.
2. Strikes Return/Enter key with right little finger; then
returns finger to home key.......................................
3. Keeps eyes on source copy during and following
return .......................................................................
4. Starts new line without a pause...............................
Shift keys .......................................................

Rating

1. Reaches quickly with little fingers; keeps other
fingers on home row ................................................
2. Depresses shift key as the character key is struck .
3. Releases shift key quickly after character is struck.
4. Does not pause before or after shift-key stroke ......
Tab key ...........................................................
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